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CHAPTER 1: INTRODUCTION

1 Introduction

In the field of natural hazards there is an increasing need for process models to help understand the
motion of geophysical movements. These models allow engineers to predict the speed and mass of
hazardous movements in complex terrain. Such models are especially helpful when processing miti-
gation measures, such as avalanche dams or snow sheds. Hazard mapping is an especially important
application in Switzerland and other mountainous countries. An accurate prediction of runout dis-
tances, flow velocities and impact pressures in general three-dimensional terrain is the driving moti-
vation for the development of dynamical mass movement models. Although helpful and well-liked by
users, one-dimensional models such as AVAL-1D require that the primary flow direction and flow
width must be defined by the user in advance. This is often difficult, especially in open terrain, or in
terrain consisting of several possible flow channels. Furthermore, flow interaction with catching and
deflecting dams cannot be accurately modeled using one-dimensional simulation codes.

RAMMS (Rapid Mass Movement Simulation) is a two-dimensional, state-of-the-art numerical simula-
tion model to calculate the motion of geophysical mass movements (snow avalanches, rockslide,
debris flows and shallow landslides) from initiation to runout in three-dimensional terrain. It was
designed to be used in practice by hazard engineers who need solutions to real, everyday problems.
It is coupled with a user-friendly visualization tool that allows them to easily access, display and ana-
lyze simulation results. New constitutive models have been developed and implemented in RAMMS,
thanks to calibration and verification at full scale tests at sites such as Vallée de la Sionne. These
models allow the application of RAMMS to solve both large, extreme avalanche events as well as
smaller mass movements such as hillslope debris flow and shallow landslides.

RAMMS is developed since 2010 by the RAMMS team at the WSL Institute for Snow and Avalanche
Research SLF, and since July 1°t 2024 by Marc Christen at RAMMS AG. This manual describes the fea-
tures of the RAMMS program — allowing beginners to get started quickly as well as serving as a refer-
ence to expert users.

The RAMMS web page https://www.ramms.ch provides useful information such as a forum, fre-

quently asked questions (FAQ) or recent software updates. Please visit this web page frequently to
stay up to date!

1.1 Motivation

Mitigation of natural hazards relies increasingly on numerical process models to predict the area
inundated by rapid geophysical mass movements. These movements include

e snow avalanches,

e torrent based debris flows and hillslope debris flows,
e mudslides,

e ice avalanches and glacier lake outbreaks

e rockfalls and rock avalanches.

Process models are used by engineers to predict the speed and reach of these hazardous movements
in complex terrain. The preparation of hazard maps is a primary application. The models are especial-
ly helpful when proposing technical mitigation measures, such as dams and embankments or rockfall
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protection barriers. The models allow hazard engineers to optimize limited financial resources by
studying the influence of different hazard scenarios on defense options.

1.2 RAMMS

The RAMMS (RApid Mass Movements Simulation) software system contains three process modules:

e  RAMMS::AVALANCHE
e RAMMS::DEBRISFLOW
e RAMMS::ROCKFALL

The RAMMS::AVALANCHE and RAMMS::DEBRISFLOW modules are designed for flow phenomena
containing fast moving particulate debris of snow and rocks. In the avalanche module, the interstitial
fluid is air, whereas in the debris flow module the interstitial fluid is mud. The RAMMS::AVALANCHE
and RAMMS::DEBRISFLOW models are used to calculate the motion of the movement from initiation
to runout in three-dimensional terrain. The models use depth-averaged equations and predict the
slope-parallel velocities and flow heights. This information is sufficient for most engineering applica-
tions. Information in the slope-perpendicular direction (e.g. mass and velocity distribution) is lost;
however, this is seldom of practical interest. Both models require an accurate digital representation
of the terrain. Engineers specify initial conditions (location and size of the release mass) and friction
parameters, depending on terrain (e.g. roughness, vegetation) and material (e.g. snow, ice or mud
content of the debris flow).

The RAMMS::ROCKFALL module is used to study the rigid body motion of falling rocks. The model
predicts rock trajectories in general three-dimensional terrain. Rock trajectories are governed by the
interaction between the rock and ground. The model contains six primary state variables: three
translational speeds and three rotational velocities of the falling rock. From these, kinetic energy,
runout distance and jump heights can be derived. Generalized rock shapes are modeled. Rock orien-
tation and rotational speed are included in the rock/ground interaction. The RAMMS::ROCKFALL
module is therefore fundamentally different from the RAMMS::AVALANCHE and
RAMMS::DEBRISFLOW modules because it is based on hard-contact, rigid-body Lagrangian mechan-
ics, not Eulerian flow mechanics. It also differs from existing rockfall modules because the
rock/ground interaction is not governed by simple rebound mechanics, but frictional (dissipative)
rock/ground interactions. These govern the onset of rock jumping. The RAMMS::ROCKFALL module
predicts all rigid-body motions — rock sliding, rolling, jumping and skipping.

In all RAMMS modules, new constitutive models have been developed and implemented, thanks to
calibration and verification at full scale test sites such as St. Léonard/Walenstadt (rockfall, mitiga-
tion measures), Vallée de la Sionne (snow avalanches) and lligraben (debris flow).
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1.3 Learning by doing

This manual provides an overview of RAMMS::AVALANCHE. Exercises exemplify different steps in
setting up and running a RAMMS simulation especially in Chapter 3 ‘Setting up a Simulation’. Howev-
er, to get the most from the manual, we suggest reading it through while simultaneously having the
RAMMS program open, learning by doing. We assume RAMMS users to have a basic level of familiari-
ty with Windows-based programs, commands and general computer terminology. We do not de-
scribe the basics of windows management (such as resizing or minimizing). RAMMS windows, click
options and input masks are similar to other Windows based programs and can be used, closed,
reduced or resized in the same way.

DISCLAIMER

The RAMMS software models are provided "as is" without any warranties, express or implied.
RAMMS AG makes no representations or warranties of any kind, including but not limited to the ac-
curacy, reliability, completeness, or suitability of the models for any particular purpose

Users of the RAMMS software models assume all risk associated with the use of these models.
RAMMS AG shall not be held liable for any loss, injury, or damage resulting from the use or reliance
on these models, including but not limited to personal injury, property damage, or financial loss.

The RAMMS software models are intended to supplement, not replace, the judgment and expertise
of professionals in the fields of geology, engineering, and hazard management. Users should not rely
solely on the models for making decisions related to hazard mitigation, land use planning, or emer-
gency response.

In no event shall RAMMS AG be liable for any indirect, incidental, special, consequential, or punitive
damages arising out of or in connection with the use or performance of the RAMMS software mod-
els, even if advised of the possibility of such damages.

Users are responsible for ensuring that their use of the RAMMS software models complies with all
applicable laws, regulations, and standards. RAMMS AG does not guarantee that the models meet
any regulatory requirements or industry standards.

RAMMS AG may, at its sole discretion, update, modify, or discontinue the RAMMS software models
at any time without notice. Users are responsible for ensuring that they are using the most current
version of the models.

By using the RAMMS software models, you acknowledge that you have read, understood, and agree
to be bound by the terms of this disclaimer.

Swiss law applies. Court of jurisdiction is Davos. If you encounter problems, please contact

info@rammes.ch.
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2 Installation and Setup

2.1 System requirements

We recommend the following minimum system requirements for running
RAMMS::AVALANCHE:

e Operating Systems: Windows 10 and higher (64-bit)
32-bit systems (Win XP) are not supported anymore

o RAM (memory): 4 GB (more recommended)

e CPU: >1 GHz, 2 cores or more recommended

e Disk space: ca. 220 MB needed for the software

2.2 Installation

Please download the RAMMS::AVALANCHE setup file “ramms_user _setup 64.zip” from
https://www.ramms.ch/ramms-avalanche/ (Downloads at the bottom of page).

Please do the following steps before beginning to install RAMMS:

e C(Clickon the path given above or copy the path to any browser. A window pops up and the
automatic download of the file ramms_user_setup 64.zip starts after clicking Yes.

e Unzip the file to a temporary location.

e You must have Administrator privileges on the target machine. If you do not have such
privileges, the installer cannot modify the system configuration of the machine and the
installation will fail. Note that you do not need Administrator privileges to run RAMMS af-
terwards.

e Read first, install afterwards! Please read the whole installation process once, before you
begin the installation.

e Start the file “ramms<version>_user_setup 64.exe”.
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Step 1: Welcome

The welcome dialog introduces you to the English setup program and will guide you through the
installation process. Click Next to continue.

& installing RaMMS =10l =]

RAMMS Welcome to the RAMMS Installation!
1.5

~
” This setup program will install RAMMS on your computer. Click
3 Cancel if vou do not want to install this application. Click Next to
o continue the installation.

WrARMING: This program is protected by international copyright
law and treaties,

iﬁ/ Unauthorized reproduction or distribution of this program, or any
* w

portion of it, may result in severe civil and criminal penalties and
will be prosecuted to the maxirum extent of the law.
- R

Createlnstall Free
Mext = | Cancel

Figure 2-1: Installation - welcome dialog window.

Step 2: Readme

Short introduction to RAMMS. Click Next to continue.

‘7 Installing RAMMS = %
Readme i?lll.k
Flease read the following information.
RS
RAMMS 1.6.20 (Rapid Mass MovementS) -

RAMMS (Rapid Mass MovementS) is a state-of-the-art numerical simulation model
to calculate the motion of geophysical mass movements (snow avalanches,
debris flows, rockfall and shallow landslides) from initiation to runout in three-
dimensional terrain. It was designed to be used in practice by hazard engineers
who need solutions to real, everyday problems. It is coupled with a user-friendly |=
visualization tool that allows users to easily access, display and analyze
zimulation results. New constitutive models have been developed and
implementad in RAMMS, thanks to calibration and verification at full =cale tests at
sites such as Vallée de la Sionne (snow avalanches), Illgraben (debris flows),
eltheim (hillslope) and St. Leonard / Walenstadt (rockfall). These models allow
the application of RAMMS to solve both large, extreme awvalanche or debriz flow
events as well as smaller mass movements such as hillslepe debris flows and
shallow landslides.

[ < Back ] [ Next = ] [ Cancel

Figure 2-2: Installation - Readme dialog window.
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Step 3: Accepting the license agreement

Read the license agreement carefully and accept it by activating the check box in the lower left
corner. If you do not accept the license agreement, you are not able to proceed with the installa-
tion. After accepting the license agreement, click Next to continue the installation.

7} Installing RAMMS = EY

License Agreement ﬁ*
To proceed with the installation, you must accept this License

Agreement. Please read it carefully. /{SF

RAMMS - General License Agreement -

Fleaze read the following general licence agreement carefully. If you do not =
agree with the conditions, do not install the RAMMS zoftware. The licence fee will

be returned to you. By installing the RAMMS software, you accept the following
contract conditions.

A. PROGRAM RAMMS

1. RAMMS iz a program developed by the WSL Institute for Snow and Avalanche
Rezearch SLF. The functions of the program are described in the handbook
delivered with the program.

2. RAMMS and the handbook are protected by copyright. All rights are reserved
by WSL/SLF.

[¥]1 agree with the above terms and conditions

’ < Back ] ’ Next = ] [ Cancel ]

-]

Figure 2-3: Installation - license agreement dialog window.

Step 4: Select destination directory

Choose your destination directory. This dialog shows the amount of space available on your hard disk
and required for the installation. Click Next to start the installation process.

7} Installing RAMMS = £
Destination folder }1}’*
Select a destination folder where RAMMS will be installed.

Setup will install files in the following folder.

If you would like to install RAMMS into a different folder then click Browse and
select another folder.

DW&H&\
( C:\Program Files ()cSG]\RAMMS) Browse...

Space required: 218.52MB
Space available: 4.76GB

’ < Back ] ’ Mext = ] ’ Cancel ]

Figure 2-4: Installation - destination directory dialog window.
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Step 5: Installing the files

RAMMS is copying the files to the destination location. The window shows the installation pro-
gress.

; Installing RAMMS (= @

Installing Files *
Copying RAMMS files to your computer. */ﬁ“(
A

To interrupt or pause the installation process, click Cancel.

Directory: C:\Program Files (x86)\RAMMS\bmp
File: LOGO.BMP

Next > Cancel

Figure 2-5: Installation - installing files dialog window.

Step 6: Finished installing the files

RAMMS finished copying the files. Click Next to finish the installation process.

:;3 Installing RAMMS [=] gi

Installing Files S.?llk

Copying RAMMS files to your computer. *sz:F
SUF

Click Next to continue the installation.

[ Next = ] [ Cancel ]

Figure 2-6 : Installation - finished installing files dialog window.
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Step 7: RAMMS installation finished!

RAMMS successfully finished the installation. Click Finish.

R el
Mﬁ“ﬁ, RAMMS has been successfully installed!
'3.. 1-5 h
| :iJ
1. L\. . Click Finish to complete the installation.

A}‘Igv

Createlnstal] Free

Figure 2-7: Installation - finished installation dialog window.

Step 8: Welcome to IDL Visual Studio Merge Modules

To ensure that all important system libraries are installed on your target machine follow the in-
structions below:

The welcome dialog introduces you to the English setup program and will guide you through the
installation process of the IDL Visual Studio Merge Modules. Click Next to continue.

i IDL Visual Studio Merge Modules - InstaliShield Wizard X

Welcome to the InstallShield Wizard for IDL
Visual Studio Merge Modules

The InstallShield{R) Wizard will install IDL Yisual Studio Merge
Modules on your computer. To continue, click Next.

WARNING: This program is protected by copyright law and
international treaties.

[ Next > ] [ Cancel ]

Figure 2-8: IDL Visual Studio Merge Modules - welcome dialog window.
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Step 9: Ready to install the program

ii& IDL Visual Studio Merge Modules - InstallShield Wizard

Ready to Install the Program \ ‘ I |

The wizard is ready to begin installation.

Click Install to begin the installation.

1f you want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard,

[ < Back ][ Install ] [ Cancel ]

Figure 2-9: IDL Visual Studio Merge Modules - ready to install the program.

Click Next to continue.

Step 10: Installing IDL Visual Studio Merge Modules
The wizard is installing the files. Please wait until it is finished.

i IDL Visual Studio Merge Modules - InstallShield Wizard

Installing IDL Yisual Studio Merge Modules

The program features you selected are being installed.

[d]| Please wait while the InstallShield Wizard installs IDL Visual Studio Merge
Modules, This may take several minutes.,

Status:

[--------------------lII---IIIII-----II- ]

< B

Sack Next = Cancel

Figure 2-10: IDL Visual Studio Merge Modules - installing...
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Step 11: InstallShield Wizard Completed
The wizard completed the installation. Click Finish.

i IDL Visual Studio Merge Modules - InstallShield Wizard @

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed IDL Yisual
Studio Merge Modules. Click Finish to exit the wizard.

Figure 2-11: Installation - destination directory dialog window.

After having successfully installed RAMMS and the necessary files on your personal computer, you

will notice the RAMMS icon on your desktop (for all users):

eedialii
L A ]

Figure 2-12: RAMMS icon.

Additionally, a new application folder is created in Start - Programs (for all users):

o  RAMMS - Run RAMMS
e  RAMMS - Uninstall RAMMS

. RAMMS
€% Run RAMMS
B4 Uninstall RAMMS

Figure 2-13: RAMMS program group
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2.3 Licensing

Access to RAMMS is controlled by a personal use license. Personal use licenses are time limited
licenses tied to a single personal computer. This method of licensing requires a machine’s unique
host ID to be incorporated into a license request file. After the license request file is sent to
RAMMS AG, you will receive a license key. Entering the license key on a personal computer ena-
bles full RAMMS functionality for the specific personal computer. For more information, please
visit https://www.ramms.ch. Alternatively, the license can be installed on a Windows Server

and accessed by different users (only one at a time) by RDC (Remote Desktop Connection).
This only works for one license per module.

2.4 First start

Double-click the RAMMS icon or use Start - Programs -> RAMMS - Run RAMMS to start RAMMS
for the first time. Whenever you start RAMMS, the splash screen below will pop up:

'IDL

Virtual Machine

Distribution Platform To Run
IDL Applications

Click To Continue

Figure 2-14: RAMMS start window.

Click on the image. It will disappear and RAMMS will start up. The following dialog window appears
(Figure 2-15 RAMMS Licensing):

[ @ RAMMS 1.6.20 - Licensing L= J
Create perzsonal license request file:
|| LICENSE KEY:
| cancel | | ok |

Figure 2-15: RAMMS licensing window

11
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ZRAMMS 1.5.01 x|

Enter USERHAME and COMPANY HAME:
Chooze EAMME module:

¥ Avalanche 1 Debris Flow

Lzermame: I

COmpanty: I

Cancel | OK |

Figure 2-16: Enter user name and company name.

2.4.1 Personal license request file

Click the button to create your personal license request file. In Figure 2-16 enter your full
name and the name of your company.

In the next dialog window, choose the destination directory of your personal license request file and
save it to your target machine. Your personal license request file should look similar to Figure 2-17.

&} RAMMS _request_Muster Test.txt - Edi -10] x|
Datei Bearbeiten Format 7?
Username: Muster Test -l

Company. Test
HostlD:  0d033d4f6c09|

K| ;IJ//

Figure 2-17: Personal license request file RAMMS_DBF_request_TestName.txt

2.4.2 Getting the personal license key

You find order forms on the RAMMS website (Full License, Demo License or Student License) at
https://www.ramms.ch/shop/.

12
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An order confirmation email is sent to your email address. We then process your order and send
you an invoice. You will find all the banc details on this invoice for a banc transfer. You can also pay
by credit card. After we have received your payment, we will send you your personal license key,
valid according to the license period you purchased. Your personal license key is named in the fol-
lowing manner:

“AVA 20151013 TestName_TestCompany RAMMS_TimelLicense.txt”. Open the file in a text
editor. It should look similar to

Figure 2-18 below. The filename reveals also the end date of your license period, e.g.
“20151013” = October 13t 2015.

Datei Bearbeiten Format  Ansicht ©

Username: Muster Test ;
Company: Test

Installation Key: AVALANCHE agjk-hmih-iklu-jk42-11h3

| |

- o .

Figure 2-18: Personal license key file RAMMS _license_Muster Test.txt

Now, restart RAMMS (as explained before). The IDL splash screen appears (Figure 2-14) and then
the dialog window of Figure 2-15 shows up (RAMMS - Licensing). Copy the license key (in this
example: AVALANCHE agjk-hmih-ik1u-jk42-11h3) and paste it in the field LICENSE KEY (see Figure
2-15). Notice that there is the prefix AVALANCHE. This prefix is part of the license key and has to
be inserted as well! If RAMMS accepts your installation key, you successfully finished the installa-
tion.

2.4.3 License Transfer
If you want to transfer your RAMMS license to a new PC, do the following:

e install RAMMS on the new PC

e generate a new license request file

e send us the new license request file TOGETHER with your old license file by email
e we will then send you the new license file (email)

e uninstall RAMMS from your old PC

2.5 Update
When you start RAMMS it will automatically check for updates on the internet. This can lead to an
error message, if your firewall blocks the executable idirt.exe (this file starts the IDL-Virtual Machine
you need to run RAMMS). Please unblock this file for your firewall. You can also disable the
AutoWebUpdate-function by unchecking Help > Advanced... - AutoWebUpdate. In the same way
you can enable the AutoWebUpdate-function by checking Help > Advanced... -> AutoWebUpdate.

13
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3 Setting up a simulation

3.1 Preparations

To successfully start a new RAMMS project, a few important preparations are necessary. Topo-
graphic input data (DEM in ASCII- or GEOTIFF-format), project boundary coordinates and georef-
erenced maps or orthophotos should be prepared in advance (.tif format and .tfw-file, maps and
orthophotos are not mandatory, but nice to have). Georeferenced datasets have to be in the same
Cartesian coordinate system (e.g. Swiss CH1903 LV03) as the DEM. Polar coordinate systems in
degree (e.g. WGS84 Longitude Latitude) are not supported. For more information about specific
national coordinate systems please contact the national topographic agency in your country.

3.1.1 Topographic data - Digital Elevation Model (DEM)

The topographic data is the most important input requirement. The simulation results depend
strongly on the resolution and accuracy of the topographic input data. Before you start a simulation,
make sure all important terrain features are represented in the input DEM. RAMMS is able to
process the following topographic data:

1. ESRIASCIl grid (Figure 3-1)
2. GEOTIFF (georeferenced information embedded within a TIFF file)
3. ASCII XYZ regular, single space data (Figure 3-2)

ASCII XYZ data (regular and irregular) can be converted within RAMMS into an ASCIlI or GEOTIFF grid.
A wizard will guide you through the conversion process. The following interpolation methods are
available: LINEAR or INVERSE DISTANCE.

The header of an ESRI ASCII grid must contain the information shown below in Figure 3-1.

B lenzerheide_dem.asc - WordPad 8 dim-av_grid_subset.xyz - WordPad
e ?
el e enen i (NI S TOR RETRE, Datei Bearbeten Ansicht Einfugen Format 7

D S #M @ 7.3 =
D S M @ 7.
ncols 1157 "
nrovs 51, 679000.00 236500.00 791.33
xlicorner 153929 679002.00 236500.00 791.73
yllcorner 178911 "
e x 679004.00 236500.00 792.07
NODATA value -9939 679006.00 236500.00 792.58
1667.2 1666.67 1665.84 1665.16 16649.96 1665.45 1666.61 1668 679008.00 236500.00 793.01
1665.8 1665.03 1664.58 1664.47 1664.9 1666.06 1667.78 1668.9 675010.00 236500.00 793.47

1664.05 1663.9 1664 1664.31 1665.09 1666.89 1668.44 1669.28

2 3
1662.43 1663.17 1663.86 1664.45 1665.78 1667.79 1669.15 1670 679012.00 236500.00 793.93

1661.27 1662.33 1663.92 1665.06 1666.76 1668.91 1671.24 1671 679014.00 236500.00 794.38
1661.57 1662.53 1663.77 1666.16 1668.46 1669.98 1671.7 1672. 679016.00 236500.00 794.87
1662.89 1663.57 1664.79 1667.08 1669.38 1670.83 1672.67 1673 679018.00 236500.00 795.43
1664.96 1665.22 1665.73 1668.08 1670.02 1671.3 1674.13 167S. 679020.00 236500.00 795.96

1666.74 1666.83 1667.49 1669.27 1670.54 1672.33 1674.98 1675
1668.36 1669.06 1669.8 1671 1672.33 1673.71 1675.47 1676.45

Figure 3-1 : Example ESRI ASCII grid. Figure 3-2: Example ASCII XYZ single space
data.

679022.00 236500.00 796.48
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3.1.2 Project and Scenarios

A project is defined for a region of interest. Within a project, one or more scenarios can be speci-
fied and analyzed. For every scenario, a calculation can be executed. A project consists therefore
of different scenarios (input files) with different input parameters. The basic topographic input
data is the same for every scenario. If you want to change the topographic input data (e.g.
change the input DEM resolution or the project boundary coordinates) you have to create a new
project. Other input parameters (such as release area, calculation domain, calculation grid resolu-
tion, end time or time step) can be changed for every scenario.

WO
A C\'ir el&(:B// ‘Wﬁ

;.yx'ﬁ'w / )
. 2
/%

< Upper right corner [] ';_'
(X max, Y max) _ oy

e S 19 [

=

N

Lower left corner e

(X min, Y min) ”;‘ 7

mln min O >

s MM //ﬁ'y// 27
"J//?\'w Yv £ / ’// Setllor

Figure 3-3: The same project extent (area of mterest) can be used to
calculate different scenarios with different input parameters.

3.1.3 Release information

The definition of release areas and release heights have a very strong impact on the results of
RAMMS simulations. Therefore, we recommend to use reference information such as photography,
PGS measurements or field maps to draw release areas. This should be done by people with experi-
ence concerning the topographic and meteorological situation of the investigation area.

Users can use any polygon shapefile as a release area, see section 3.5.1 on page 38. Release areas
drawn in RAMMS are saved as polygon shapefiles and can be easily imported in GIS-Software (e.g.
ArcGIS or QGIS). Shapefiles created in e.g. ArcGIS or QGIS can of course be used in RAMMS.
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3.1.4 Friction information

RAMMS employs a Voellmy-fluid friction model, which is based on the Voellmy-Salm approach (we
refer to Salm et al. 1990 [3] and Salm 1993 [4]).

Physical friction model

The physical model of RAMMS::AVALANCHE uses the Voellmy friction law. This model divides the
frictional resistance into two parts: a dry-Coulomb type friction (coefficient u) that scales with the
normal stress and a velocity-squared drag or viscous-turbulent friction (coefficient £). The frictional
resistance S (Pa) is then

u? 3.1
Pg with N = phgcos(¢) 3.1)

S =uN +

where p is the density, g the gravitational acceleration, ¢ the slope angle, h the flow height and u
the vector u = (uxuy)", consisting of the avalanche velocity in the x- and y-directions. The nor-
mal stress on the running surface, phgcos(¢p), can be summarized in a single parameter N. The
Voellmy model accounts for the resistance of the solid phase (u is sometimes expressed as the tan-
gent of the internal shear angle) and a viscous or turbulent fluid phase (¢ was introduced by
Voellmy by using hydrodynamic arguments). The friction coefficients are responsible for the behav-
ior of the flow. u dominates when the flow is close to stopping, { dominates when the flow is
running quickly.

Throughout one simulation the friction coefficients of a calculation domain are constant. However,
you have the possibility to add up to two polygons within the calculation domain with different
friction parameters (see section 3.5.4 “How to run a calculation” on page 50.)

The Voellmy friction model has found wide application in the simulation of mass movements,
especially snow avalanches. For modeling snow avalanches the Voellmy model has been in use in
Switzerland for many years and a set of standard parameters is available.

Cohesion

Since Version 1.6.20 the basic Voellmy equation has been modified to include a cohesion (Bartelt et
al. 2015 [5]). Many materials, like mud and snow, do not exhibit a simple linear relation (u = con-
stant), see Figure 3-4. To model yield stress, we introduce the parameter Ny. With this approach it is
possible to model ideal plastic materials. In this case Nyserves as a yield stress and u a "hardening"
parameter. The new equation for the frictional resistance S is then

2 N

u N
LS (1= WNo — (1 — WNge Mo

S =uN +

where Ny is the yield stress of the flowing material. Unlike a standard Mohr-Coulomb type relation
this formula ensures that S50 when both N-0 and U-0. It increases the shear stress and therefore
causes the avalanche to stop earlier, depending on the value of Ny .
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—
P

g g
~ Cohesion —
n n
a3 >0 A Visco-plastic
S . o
o .7 2 L=0
@© -7 ] I
2 N, _-~ No cohesion 2 N,
n e n
- —— —
Normal stress N (Pa) Normal stress N (Pa)

Figure 3-4: Relation between normal and shear stress. Left: Yield stress Ny serves to increase the
shear stress for higher normal pressures. At low normal pressures
(small flow heights) the shear stress increases rapidly from S=0 to S=No.
The slope of the ‘S vs N’ relation remains u, when the normal pressures are large.
Right: If u=0, we have a visco-plasic behaviour.

Curvature

Since Version 1.6.20, the normal force N includes centrifugal forces arising from the terrain curva-
ture. We use the method proposed by Fischer et al. (2012) [6], which was specifically developed for
RAMMS. The centrifugal acceleration f is both a function of the avalanche velocity and terrain curva-
ture. The acceleration is calculated according to

f = uKu”

The matrix K describes the track curvature in all directions, including the track “twist”. The
centrifugal force is then

F = phf

which is added to the normal force N. Typically this increases the friction, causing the avalanche to
slow down in tortuous and twisted flow paths. It can change the location of the deposition once the
flow leaves the gully. Curvature may be activated/deactivated in the Run Simulation window (tab
Params) or via the menu ‘Help - Advanced... - Curvature’.

Friction parameters p and §

RAMMS::AVALANCHE offers a constant and a variable calculation mode. If a calculation is done with
constant friction values, of course, no terrain undulations and forest areas are considered. There-
fore, we suggest to use the variable friction values if possible. u and € values are saved as ASCII files
(called MuXi-files) and can be easily imported in GIS-Software (e.g. ArcGIS)

The creation of a new MuXi-file is demonstrated in the exercise 3.5e “How to create a new MuXi-
file” on page 49.
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Automatic MuXi Procedure

First Step: RAMMS performs a terrain analysis, where slope angles and curvatures are analyzed, re-
sulting in four classification classes: flat, open slope, channeled and gully, see example in Figure be-
low.

Flat
Open slope
Channeled

Gully

Figure 3-5: Automatic terrain analysis in RAMMS

In the next step, RAMMS uses the classification from above together with forest information, global
parameters (return period and avalanche volume, see Figure 3-8) and altitude limits to assign the p
and ¢ values.

Large avalanche | > 60 000 m ) [ toovesr | 30-ear 10-Vear
[ £ 1] E 1] E
0165 SO0 [} T L¥E] oW
5L 500 (i) i) T e
T i) T THE T T
3] i [ ] [ |
(¥ 1750 (5] 1750 (¥ 750
LR 55 550 637 R
[R5 TS0 LA L
5 [} pEL] [ L
A TIE 1500 LR 500 LS T
-t T 0 TTEE 0 TEE ]
e TIE ELi] [:5) L] [5E] =]
é%«"‘:}f%ﬁ:" < N 3000 (N5 3000 [ 000
‘%@( 0?" e ' - 100-Year 5 30-Yaar - 10-¥ear
R e R T = — oW
e ﬁ%r, Yl - T P 1 e P -
it [3) 756 L ] T3 T
e BT A
L M HAN 1
e, 5 ‘

i

eyl
L
b

Figure 3-6: Automatic assigning of u and € values to grid cells
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Altitude limits

The default altitude limits that are used in the Automatic MuXi Procedure, are 1000 and 1500

m.a.s.l., valid for the Alps.

@“ RAMPMS | Automatic MuXi Procedure
Volume = LARGE Return period = 30 Cancel OK
(Opticnal: if empty -= default name}
MulXi name:
Altitude Limits (m.asl) 1: 1500 | 2: 1000

Above Altitude Limit 1

Open Slope - Mu:

| 0.170 | }ﬁ:| 3000 |

Figure 3-7: Altitude limits for automatic MuXi procedure

The two altitude limits can be interpreted as follows:

e Alt. Limit 1 (higher value): Tree line of your project region should be higher than this limit

e Alt. Limit 2 (lower value): Snow line of your project region

Example altitude limits are provided (only suggestions, without warranty) in the table below:

Table 1: MuXi Altitude Limits, examples for different climatic regions

Regions RAMMS Altitude Limits Climate

Tree line (m) Snow line (m)
Alps 1500/ 1000 2100 1000
Bansko (BUL) 1500/ 1000 2100 1000
Pyrenees 1700/ 1200 2200 1200
Socchi (RUS) 1700/ 1200 2200 ?
Norway (West Coast) 500/ 200 800 100
Juneau (USA) 500/ 200 700 200?
Wyoming (USA) 2000/ 1500 3000 1500?
Chile (Santiago Region) 2500/ 2000 3000 2000
Himalaya (Manali, India) 3000/ 2500 3500 2000
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3.1.5 Global parameters

The friction values p and ¢ strongly depend on the global parameters return period and avalanche
volume (see MuXi-table on page 101). Therefore, an appropriate return period has to be defined
and the avalanche volume has to be checked under Input = Global Parameters prior to creating a
new MuXi-file (see Figure 3-8 and exercise “How to create a new MuXi-file” on page 49).

Global MuXi Parameters

Return period (vears)
300 ©100 @ 30
Awalanche volume category

@ Large () Medium ) Small () Tiny

’ Cancel ] ’-DK ]

Figure 3-8: RAMMS global parameters.

3.1.6 Forest information

Forest information is not required for a successful simulation, but recommended, because the fric-
tion parameters strongly depend on forest information. Forest information can be provided as:

e ESRI ASCII grid (0: no forest, 1: forest)
e Polygon shapefile

If no such files are available, the user can draw a polygon shapefile in RAMMS and import it as forest
information (see section 3.5.3 on page 47).

3.1.7 Calculation parameters

Calculation parameters such as output name, simulation grid resolution, end time, time step etc. can
be changed interactively in the RAMMS Run Simulation Widget.
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3.2 Preferences

You can set your RAMMS preferences and place the necessary DEM (Digital Elevation Model) files as
well as the forest files, maps and georeferenced orthophotos you wish to use in the appropriate
folders defined in the preferences see Figure 3-9 and Figure 3-10 below. This is optional, you do not

have to use these folders.

Use Track —> Preferences to open the RAMMS preferences window or click the button . For
resetting the general preferences use Help - Advanced... - Reset General Preferences.

@ RAMMS Preferences

D<)

General | Avalanche

Lyalanche

Working directory
Map directory
Orthophoto directory
DEM directory
FOREST directony

I Mr Of Colorbar Colors 50
GIF-Animation Interval (s) |1
Backaground Color .[D-D-D}

I Animation Delay (z) 0.1

Figure 3-9: General tab of RAMMS preferences.

General Tab

Setting
Working Directory

[Cancel][ OK ]

[Cancel][ OK ]

- E 4

Figure 3-10: Avalanche tab of RAMMS
preferences.

Purpose

Set your working directory. VERY IMPORTANT: DO NOT USE BLANKS
in the working directory path!

Map Directory

Set the folder where you place your georeferenced digital maps
(consists of a .tif file and a corresponding .tfw file (world-file).

Orthophoto Directory

Set the folder where you place your digital georeferenced orthopho-
tos (aerial picture, consists of a .tif file and a corresponding .tfw file
(world-file).

DEM Directory

Set the folder where you place the Digital Elevation Models (format
ASClII grid, see section 3.1.1 on page 21)

FOREST directory

Set the folder where you place your forest-files (formats: ASCII grid
or polygon shapefile).
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Avalanche Tab

Setting Purpose

Nr of colorbar colors Set default nr of colorbar colors.

GIF-Animation Interval [s] Set interval for GIF animation images.

Background Color Set background color (greyscale between 0: black and 255: white).
Animation Delay [s] Set animation delay to decelerate the animation speed.

The following exercise Working directory shows how to choose a new working directory. All further
settings can be changed in a similar manner. The settings are saved, until they are changed again

manually.

Exercise 3.2 : Working directory

Choosing the right working directory is very useful and saves a lot of time searching for files and
folders.

VERY IMPORTANT: Do NOT use blanks or special characters in the path names!

e C(lick (or use Track - Preferences or Ctrl+P) to open the RAMMS preferences window.
o C(lickinto the field Working directory. A window pops up where you can choose your new
working directory. Click OK in both windows. Do this also for other directories if necessary.

[ ™
RAMMS Preferences [ = ] e oo R |
Please Select a Directory
General | Avalanche 4y Local Disk (D7) B
4 ",‘1: buehlery
Working directory 1D:\bushlery\RAMMS\ S j—
Map directary D-\buehlery\RAMMS", 1 oot
. . - » L. Bilder_privat _
Orthophoto directory | D:\bushleny\RAMMS?, | O dato =
DEM directary D buehleny RAMMS" = ELSS-WJE‘“
FOREST |j||'e|:‘t|:|r!'r j . Lawinenvideos
> Lehre
> Literatur
[ Cancel ] [ 0K ] > | LMSTEIN_projects
d > my_projects
Panasonic_pictures
> Publications
Figure 3-11: RAMMS preferences [l ravs
4 RernoteSensing -
[ Make New Folder ] [ oK ][ Cancel ]

Figure 3-12: Browse for the correct folder.

22



CHAPTER Error! Use the Home tab to apply Uberschrift 1 to the text that you want to
appear here.: APPENDIX

3.3 Creating a new project
A new project is created with the RAMMS Project Wizard, shown in the exercise below. The Wiz-

ard consists of four steps:

Exercise 3.3: How to create a new project

o C(lick or Track - New... - Project Wizard to open the RAMMS Project Wizard.
e The following window pops up.

| RAMMS | Avalanche Project Wizard | 2 |

Project Wizard - Step 1 of 4

Project Information

Enter project name, project detailz and location of the project in
the fields below. The project name wil be used to name your
project directory and your input files. |

Project name:

Project details:

Location:

Project will be created at:

[ Cancel ] [ Previous ] [ Hext ]

Figure 3-13: RAMMS Project Wizard Step 1 of 4
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Continuation of exercise 3.3: How to create a new project

Step 1:

e Enter a project name (1)

e Add project details (2)

e The project location (3) suggested is the current working directory. To change the loca-
tion, click into the Location field. A second window appears and you can browse for a dif-
ferent folder (see figure below)

VERY IMPORTANT: Do NOT use BLANKS or special characters in the project location path!

o Click Next (4)

@RAMMS|AvaIanche Project Wizard | & |1

Project Wizard - Step 1 of 4

Project Information
Enter project name, project details and location of the project in
the fields below. The project name will be used to name yvour il | 52
project directory and your input files. Browse For Folder -
Project name: | Choose Project Location I
Test 1 @ 1

P::fac.t dettﬁ\lst: '; w Desktop o

is is @ tes - =

avalanche example 2 @ e * |79 Libraries E-
Location. » A Marc Christen
D\RAMMS\AVALANCHE Beizpiels) 3 @ 4 _"." Computer

Project will be created at: “;, SYSTEM (C:)
DARAMMSWAMALANCHE\Beispiele\Test = DATA (D) il

4 Fl - T S
Iﬂl M Iﬂl | Make New Folder | | oK | | Cancel |
Figure 3-14: Step 1 of the RAMMS Project Wizard Figure 3-15: Window to browse for a new project
Project Information. location.
Step 2: RAMMS | Avalanche Project Wizard l X ]
L I
e Locate your DEM-file (ASCIl or GEO- Project Wizard - Step 2 of 4
TIFF). Click into the corresponding field GIS Information
i 1 Choose DEM (Digital Elevation Model) file (ASCIl or
to brOWSG for the approprlate flle (1) GEOTIFF) and specify the grid resuldtiun of your
e The grid resolution of your DEM-file is project.
shown in (2). Change the resolution, if _
Select DEM-file:

needed (bilinear interpolation).
e Click Next (3).

@

dtm_5m_clipCrop_v2 asc 1 @

Grid Resolution

Grid Resolution (m): 5.0 2 @
3

| Cancel | | Previous | | Next |

Figure 3-16: Step 2 of the RAMMS Project
Wizard: GIS Information.
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Continuation of exercise 3.3: How to create a new project

Step 3:

e RAMMS shows the coordinates of your DEM-file (1).

e Enter the X- and Y-coordinates of the lower left and upper right corner of your project
area, using any Cartesian coordinate system (e.g. the Swiss Coordinate System CH1903
LV03), as it is shown below for the Vallée de la Sionne area.

e You can clip the DEM by entering new boundary coordinates or by specifying a polygon
shapefile (2).

e Click Next (3).

O o ITTLAL S Y] b AT
W ‘%,¢ m{;,,lu”, 7 f’_“i"

'\4?&_(; Wi e @ RAMMS | Avalanche Project Wizard | %%
eerel

MRS

N (e yj"t'V/. ‘ Upper l’ight corner Project Wizard - Step 3 of 4
s ¥ Pro'ect extent F ) Project Boundary Coordinates
‘\“i n'fr»»-,—n] 7L (X max, Y max) ¥, Enter xmin (west), xmax (east), ymin (south) and
P e, ; // 7 4 ) \, J P 4 ymax (narth) coordinates of your project
¥ ¥ max (m) NORTH
,g 1 128587.5000
%ﬁ] Xmin (m) WEST X max {m) EAST
N . 592999 5000 595694 5000
P ¥ min (m) SOUTH I
125242 5000
Clip DEM with polygon shapefile
Z ). ke | g,‘ﬂ Z 3
7RG on IR\ R R ST
ordinates: lower left and ) |
upper right corner of project area. Figure 3-18: Step 3 of the RAMMS Project

Wizard: Project Boundary Coordinates.

£ RAMMS | Avalsnche Project Wizard [ =]

Project Wizard - Step 4 of 4

Project SUMMARY

Step 4:
e Check the project summary. e :

Project Description
This is a test

e To make changes click Previous, to e R
create the prOJeCt C||Ck Create PrOject Project Location: DARAMMS\AVALANCHE\Beispiele\Test

DEN-File: DARAMMS\AVALANCHE\Beispiele\/DLS
‘wdls_dhm_Sm.asc 5
Grid Resolution: 5.00000

Project Boundary Coordinates:
Xmin (west): 582899.50
Xmax (east): 585694.50
Ymin (south): 125242.50
Ymax (north): 128587.50

{ Previous I l Create Project "Test” J

Figure 3-19: Step 4 of the RAMMS Project
Wizard: Project Summary.

Project creation:

e The creation process can take a while. Different status bars willpop up and show the pro-
gress of the project creation process.
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The following files willbe created in the project folder.

Table 3.2: Listing of files and directories created with a new RAMMS::AVALANCHE project.

Fe with « Burn
MName

doc
logfiles
\Z| dhm.asc
'@ dhm.sav
|Z| Test.av2
2| Test.dom
2] Testxyz
|| Test_dom.dbf
|| Test_ dom.shp

Test_dom.shx

RAMMS » AVALANMCHE » Beispiele » Test » -

Mew folder

=

Date modified

02,2017 11:46
02.2017 11:47
02,2017 11:47
02,2017 11:47
02.2017 11:47
02,2017 11:46
02,2017 11:46
02,2017 11:46
02,2017 11:46
02.2017 11:46

.
¥)
SIS~ S R~ R i~

Type

File folder
File folder
ASC File
IDLbinaryFile
AV2 File
DOM File
XYZ File
DEBF File
SHP File
SHX File

Search Test

3'523 KB
1'027 KB
1 KB
1 KB
2'866 KB
1 KB
1 KB
1 KB

File / Folder

Figure 3-20: Created project files

Purpose

doc (folder)

Folder containing input and output log files

logfiles (folder)

Project creation and calculation log files

dhm.tif GEOTIFF grid with altitude values

dhm.sav Compressed binary altitude information (used in RAMMS)
_.av2 Input file

_.dom Calculation domain ASCII file

_.dom.shp Calculation domain shapefile

_.dom.shx Calculation domain shapefile

_.dom.dbf Calculation domain shapefile

_.Xyz Topographic data used in RAMMS
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3.4 Working with the RAMMS GUI

Once the project is created, there are several useful tools which can be helpful when working
with RAMMS. They are explained in the sections and exercises below.

3.4.1 Open input- and output-files
The easiest way to open either input- or ouput-files is by using these toolbar buttons:

Track Edit Input Show Ru

e E W S
* I

Figure 3-21: Toolbar button to open an input file. You can also use the menu Track = Open... &>
Input File.

Track Edit Input Show FRo
X O S
+ _

Figure 3-22: Toolbar button to open an output file. You can also use the menu Track = Open... =
Avalanche Simulation.

Recent-Menu

The menu Track - Recent... allows you to directly open your 10 last accessed files (input and out-
put), without having to search for them.

3.4.2 Visualizing shapefiles, MuXi-files and domain-files

There are different ways to visualize your project files (shapefiles, MuXi-files, domain-files). In the
exercise below, we will show these possibilities.

Exercise 3.4a: Visualizing shapefiles, MuXi-files and domain-files

a. Files tab in the right panel:

e Click on the Files tab in the right AVALANCHE panel.
e In the file tree below, you will see your available project files (polygon shapefiles, MuXi ASCII
files and domain shapefiles.
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Genelal Display Volumes Region

Shapefiles, MuXi-Files and Domain-Files

E]a Polygon
|:| (] Release.shp
“-[][8) vdls_forest_all shp

+c

Figure 3-3: Files tab and available project files (fﬁ-tre_e, dEhe?retF
With the blue + button, files from external directories can be added
to the file-tree. Refresh the tree with the refresh-button.

=

e Click the checkbox next to a filename and the file will be shown in your visualization.

Files  General Display Volumes Region

Shapefiles, MuXi-Files and Domain-Files

= Polygon

[1[5) vdis_forest_all shp
3 MuXi

&3 Domain

: [E] Test_dom.shp (input)

>,
[ :

e
v
SE R 5

Figure 3-24: Selected file (Release.shp) on the right is shown in the visualization.

e You can select and visualize as many files as you like!

Shapefile properties

e Line thickness, color or linestyle can be adjusted for every individual shapefile. These proper-

ties are only saved within this RAMMS Session. Right-click on a filename and choose Shape-
file properties:
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e ok
o

Files  General Display Volumes Region

Shapefiles, MuXi-Files and Domain-Files

=) vdls fc Shapefile properties

Release properties
Import forest from shapefile
Deposition analysis

Delete

menus Shapefile properties, Release properties, Import forest from shapefile,
Deposition analysis (only output) and Delete.

. ';' .5:,
Figure 3-25: Right-click

€ RAMMS | Shapefile Pr.. X || € RAMMS | Shapefile Pr.. X [/ € RAMMS | Shapefile Pr.. X
Shapefile: Releaze.shp Shapefile: Releaze.chp Shapefile: Release.shp
Color: red - Color: red ~ Color: red w

) brown
Linestyle: Dashed s Linestyle: Dazhed L Linestyle: _v
Solid orange
Line thickness: Ling thickness: | Dotted Line thickness: | yelow
lightgreen
Dash Dot green
Cancel OK Dash Dot Dot lightblue
Long Dashes blue

Figure 3-26: Use Shapefile properties to change line thickness, color or linestyle.

i .

Release properties
e Please see section 3.5.1 on page 38 on how to specify release area properties.

Import forest from shapefile
e Please see section 3.5.3 on page 47 on how to import forest from a shapefile.

Deposition analysis
e This function is only available in output mode. Please see section 4.2.3 on page 67 on how to

do a deposition analysis.

Delete
e Delete a file from disk.

b. Adding files to the project

You can add files to the visualization using one of these options:

e Add data: Use the button ¥ or the menu ‘GIS — Add data’ to add a shapefile. If this shape-
file is located outside of your project directory, it will be added to the files-tree.
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e Add files from folder: Use the button ¥ (Add files from external directory) below the file-
tree to add all the files from an external directory to the file-tree. These files are added dur-
ing this RAMMS session. After you exit and restart RAMMS, you have to add the files again.

e Drag & Drop: see next section.

c. Drag & Drop:
It’s possible to Drag & Drop the following files onto the main visualization window:

e Input files (.av2)

e Output files (.out.gz)

e MukXi files (.asc)

e Polygon shapefiles (.shp)
e Domain shapefiles (.shp)

3.4.3 Hillshade visualization

Use Extras = Create Hillshade Image to create a hillshade visualization. For this we follow the in-
structions from ArcGIS at

https://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/how-hillshade-works.htm

to calculate the hillshade representation of your DEM, see Figures below.

Figure 3-27 DEM surface visualization (with shadows) after creating a new project in RAMMS
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Figure 3-28 Visualization after creating and adding the hillshade image to RAMMS

3.4.4 Changing maps and orthophotos (aerial images)

It is possible to change the map or orthophoto of a project anytime. Take into account, that the
corresponding .tfw-file (world-file) has to be in the same folder as the actual map (.tif). If this is not
the case, the map will not be found!

To check which map and orthophoto are currently loaded in the project, open the project input (or
output) log (Project = Input Log File). Next to map image and ortho image you will find the location
and name of the loaded map and image, respectively.

Exercise 3.4b : How to add or change maps and orthophotos

d. Add or change a map:

e Goto Extras > Add/Change Map or click _Ql
e If more than one map is found, the following window pops up, listing the maps found:
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@" Choose image - ) ‘ &l
LS
| Cancel | ‘ Load selected image |
Found several possible image files... Percent | X-Dim ¥-Dim  |Size (I.|B)|
o 100 2456 3256 224258 »
1 DARAMMS\MapsiVDLS.tif 95 2400 3200 168403
2 DARAMMS\Maps\VDLS_BIG tif 100 5593 4793 53.5005
3 DARAMMS\Mapsitest tif 100 2192 T2 334188
4 DARAMMS\Mapsivdis-bigbig tif 100 4060 4880 479636
5 DARAMMS\Mapsivdis_klein.tif S0 1864 1580 1.58750
[:3 DARAMMS\Mapshvdis_small tif 100 2192 mz 334166
7 DARAMMS\Mapsivdis_small2 tif 50 1696 1708 184428
8 DARAMMS\Mapsivdis_small3 tif 54 1782 1738 172893 ~
4 b

Figure 3-29: Window to choose map image.

Information on the image cover ratio (Percent), image dimensions (X- and Y-Dim, pixel)
and size (in MB) are provided and might be a selection criterion.
e Select the map you wish to add and click Load selected map.

e. Map not found:

e If the question "No map found, continue search?" appears, you either don’t have an ap-
propriate map, the map-folder directory is set wrong or the map is saved in a different
folder. In the second case click Yes and choose the correct folder. A window pops up to
browse for the correct map location and file.

e Or click No to cancel search.

f. Change orthophotos:
o
e Go to Extras ->Add/Change Image or click &/,

3.4.5 Moving, resizing, rotating, viewing

Exercise 3.4c: Moving and resizing the model

a. Terrain model has a dimension of 100% or smaller:

e By clicking on the arrow o the model can be moved and resized.

Figure 3-30: Active project with lines and corners for resizing.
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e To move the model without changing size or aspect ratio, move the cursor to the
model and check if the cursor turns to *3*. Then click and hold the left mouse but-
ton and drag the model to the desired position.

e To resize the model without changing the aspect ratio, use the mouse wheel to zoom
in or out. Alternatively, you can resize the model by changing the percentage value in

the horizontal toolbar il [1o0x =] ;

b. Terrain model has a dimension > 100%:

e All steps explained above are still possible.
e In addition to this, the white hand right next to the rotation button becomes active as

well. After clicking on this so-called view pan button %O , it is also possible to move
the model.

Exercise 3.4d: Rotating the model

After activating the rotation button k , the model can be rotated along the rotation axis,

by moving the cursor directly on one of the axes until the cursor changes from ESdto
wise a freehand rotation in any direction is possible.

. Other-

Figure 3-31: Active project with rotation axes.

Exercise 3.4e: How to switch between 2D and 3D mode

CIickQ] to switch from 3D to 2D view. This button then changes to M and by clicking again, you
will return to 3D view.
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Figure 3-32: 3D view of example model.

Figure 3-33: 2D view of example model.

In 2D mode you have all possibilities that work for the 3D mode. It works for input files as well as
for simulations. For the following functions of RAMMS it is necessary to switch from 3D to 2D
view:

INPUT: OUTPUT:
e Draw new polygon shapefile < e Draw new polygon shapefile <
e Release area information |i| e Draw new line profile A

a+

o [BEw ae derei b e Measure distance and angle

a+
e Measure distance and angle

3.4.6 Colorbar
As soon as a parameter is shown in the project, the colorbar appears in the panel on the right
side of the main window. It can be turned on and off by clickingon E

The colorbar can be moved anywhere in the screen (and can get lost). Use Project - Get
Colorbar to find a lost colorbar.

Exercise 3.4f: Editing the colorbar

Changing the minimum and maximum values of the colorbar as well as changing the number
of colors used is done in the panel AVALANCHE (right of the map window).

r MIN / MAX | COLORS ———— TRANSPARENCY / CONTOURS ——

Max: o Transparency %
e > 0@
w o 0@
n m 0 Simulation Centour Lines
Nr of culurs 0 @ X ﬂ @

Figure 3-34 Colorbar and visualization properties

e 1) Simply type a new value into the respective field and hit the return key on the key-
board. The display will then be refreshed.
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e 2) To view the underlying topography or image, you can change the transparency by en-

tering a value or moving the slider.

e 3) Simulation contour lines: Contour lines of simulation results can be visualized.

Default contour levels are:

- Flow height (m): 1.0 2.0 3.0 5.0 10.0 (H_CONTOUR_LEVELS)
- Velocity (m/s):1.0 5.0 10.0 20.0 30.0 40.0 50.0 (V_CONTOUR_LEVELS)
- Pressure (kPa): 1.0 3.0 10.0 30.0 100.0 (P_CONTOUR_LEVELS)

oMol 2 B ANDO e BVE

4| DEBRIS FLOW

-~

r MIN | MAX | COLORS

PARAMETER: Flow height (m)

- TRANSPARENCY | CONTOURS —

MAX o Transparency %
[o]<m > @
o [o%]
o Simulation Contour Lines
COLORS o @ % e

r Various

Files  General Volumes Region

Shapefiles, MuXi-Files and Domain-Files

+ C

=1-=3 Polygon

. =[JE& A_Hydrograph_Rel shp
[1/E) Baniers shp

i L. 121 biasho

Figure 3-35: Simulation contour lines

You can change these contour levels by adding the following lines in the Add. Preferences (be-

fore the END tag):

Example:
H_CONTOUR_LEVELS0.51.01.52.0
V_CONTOUR_LEVELS 5.0 10.0 50.0
P_CONTOUR_LEVELS 3.0 10.0 30.0

Changing colorbar color and position:

e Open the editing window by either choosing

Edit - Colorbar Properties or clicking in
the vertical toolbar.

e To change the colorbar properties simply click
into the field you want to change, then click OK.

e Under Edit -> Colorbar White Color the text-
color of the colorbar can be changed to white.
This can be useful when changing the back-
ground color of your project to white Track >
Preferences - Avalanche Tab -> Background
Color.

@ Colorbar Properties |M‘

Colorbar
Show True
Orientation  [Vertical
Color [](255.255.255)
Major ticks
Minor ticks 3
Tick interval |0
Title Release height (m)
Text color |:|[255.255255}
Text fort Helvetica
Text style Normal
Text fort size |20

| oK |
_—

Figure 3-36: The Colorbar Properties
window.
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3.4.7 How to save input files and program settings

Once a project is created, it is saved under the name and location you entered during step 1 of
the RAMMS::AVALANCHE Project Wizard (see Figure 3-13 on page 23). The created input file has
the suffix *.av2.

The second situation, in which the input file is saved automatically, is when a calculation is start-
ed. The saved input file has the same name as the created output file.

Exercise 3.4g: How to save input files and program settings manually

a. Input file:
e In case you want to save the input file manually before running a calculation, go on Track
-> Save. This is helpful when a release area was loaded but you wish to close the project
before doing the simulation.
e If you wish to save a copy of your file under a new name, go to Track - Save

Copy As or click EI
e A window pops up to choose an old file which should be overwritten or to type in a new
name, then click Save.

b. Program settings
e If you have moved and/or or rotated your project for a better view, you can save this po-
sition by going on Extras —> Save Active Position.
e You can now get back to this position anytime by choosing Extras —> Reload Position.

Exercise 3.4h : How to open an input file

e Goto Track - Open -> Input File, cIickﬁ' or use Ctrl+0.

e A window opens to browse for a avalanche input file (*.av2).

e Click Open after the file name was selected.

e The project willbe opened.

e Alternatively, you can drag & drop the input file from your windows explorer onto the
RAMMS GUI.

Exercise 3.4i: How to visualize a shapefile

e To load a shapefile go to GIS - Add data or click ﬂ
e A window opens to browse for a shapefile (*.shp).
e Click Open after the file was selected.

e Alternatively, you can drag & drop the shapefile from your windows explorer onto the
RAMMS GUI.
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Exercise 3.4j : How to open an output file/avalanche simulation

e Goto Track - Open... > Avalanche Simulation, cIick@ or use Ctrl+A.
e A window opens to browse for an avalanche simulation file (*.out.gz)

e Click OK

e The simulation willbe opened.

e Alternatively, you can drag & drop the output file from your windows explorer onto the RAMMS
GUL.

3.4.8 About RAMMS

Some information about the RAMMS installation on your computer is found here: Help > About
RAMMS. If you click on the Info-Button left of the OK-Button, RAMMS will display the
RAMMS-License Agreement.

€ About RAMMS X

RAMMS Version 1.8.0 64-bit
for Windows 8/10/11, 64-bit

This product is licensed to:
Username: Marc
Company: SLF

Licensed modules:
AVALANCHE - Expiration Date: 14.04.2025
DEBRIS FLOW - Expiration Date: 14.04.2025

Restricted Rights Legend:
Use, duplication or disclosure of this software is
subject to your license agreement with WSLISLF.

October 2022, SLF Davos Switzerland.

Copyright (c} 2010-2022 by SLFEAVSL:
Marc Christen, Perry Bartelt and others

o OK

Figure 3-37: About RAMMS
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3.5 Running a simulation

To run a calculation or a specific scenario within a newly created project (creating a project see
section 3.3 on page 23) it is necessary to define

e release area(s),
e acalculation domain
e and friction parameters p and §.

The definitions of release area(s) and release heights as well as the set of friction parameters u
and & have a strong impact on the results of RAMMS simulations, the definition of a smaller calcu-
lation domain is especially useful to keep the number of calculation grid cells as small as possible.
The exercises below show you how to create a release area, a calculation domain and a MuXi-file.
Details on the friction model used in RAMMS::AVALANCHE are given in section 0. on page 16.

3.5.1 Release area(s)

There are different possibilities to include release area(s) into the project. Since Version 1.7.0 it is
possible to specify more than one release shapefile. The following table gives an overview of the
possibilities RAMMS offers. For further explanations see the exercises below.

Create a new release area (polygon shapefile) If there is no release area available for your pro-
ject, or you wish to create a new one, switch to

2D mode and click 4@/ (Draw new polygon shape-
file)

Open an existing polygon shapefile Use the file-tree in the right-hand panel (Files)
and click the shapefile you want to visualize. Or,
use the ‘Add data’ button ¥ or menu to visual-
ize a shapefile from another source.

The definitions of release areas and release heights have a very strong impact on the results of
RAMMS simulations. Therefore, we recommend to use reference information such as photography,
GPS measurements or field maps to draw release areas. This should be done by people with experi-
ence concerning the topographic and meteorological situation of the investigation area. Release are-
as can only be drawn in 2D mode.
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Exercise 3.5a: How to create a new release area (polygon shapefile)

e Switch to 2D mode by clicking ,?‘ﬂ

e Activate the project by clicking on the map once.

o Click 4@ (Draw new polygon shapefile).

e Click into the project where you want to start drawing the outline of the release poly-

gon.

e Continue drawing the release polygon by moving the cursor and clicking the left mouse
button.

e To end the release polygon, click the right mouse button. The polygon will be closed au-
tomatically.

R e Y g
Figure 3-38: Drawing a new release area.

Before the release area is created, you have to answer a few questions:

e Add more polygon areas?
You can either answer with Yes and create a second release polygon as explained
above or answer with No and continue with the next step.

e Choose a new polygon shapefile name:
Enter a new name for the polygon area.

The polygon area will now be created and opened directly, as well as the colorbar.

39



CHAPTER Error! Use the Home tab to apply Uberschrift 1 to the text that you want to
appear here.: APPENDIX

Exercise 3.5b : How to visualize an existing release area (polygon shapefile)

Visualize shapefiles by clicking the checkbox next to the filenames in the file-tree (1, right pan-
el), use the ‘Add data’ button (2) or drag & drop shapefile(s) from the Windows file explorer
onto the RAMMS topography.

€5 RAMMS:AVALANCHE 1.7.0 - [EARAMMS\AVALANCHE\Beispiele\ Test\Test.av2] - m} X
Track Edit Input Show Run Results GIS Extras Project Help

e W& o xOoMoge@ 2 [ ANDOce M EFVE BE® [«

~ 4| AVALANCHE

PARAMETER: Flow height (m)

Files  General Display Volumes Region

Shapefiles, MuXi-Files and Domain-Files

=)-&£3 Polygon
i [ Releaseshp
[1[E) vdis_forest_all shp

{23 MuX
&#)-{Z Domain

© ES Viers+

@

@
@
B
3D
v N
(O] < >
< >
IXYZ-coordinates in lower right status bar ~ [X: 595404 97 Y- 127318 54 Altitude {m): 1570.83

Figure 3-39: How to visualize polygon shapefiles

In Figure 3-39 we selected two polygon shapefiles: 3Rel.shp, consisting of three polygons, and
2Rel.shp with two polygons. For every polygon, we can specify a release depth and/or release delay.
Not every polygon must contain a release depth, only the ones we want to release, see exercises

below.

Once polygon area(s) are created or loaded, you have to specify the release height(s). Switch to 2D
mode, choose Input - Release area... - Details/Edit release area, click the button * or right-click
the polygon shapefile in the Files-Tab and choose Release properties, and choose the release area
polygon by selecting it with the left mouse button. The appearing window (Figure 3-40) yields infor-
mation about release area, mean slope angle, mean altitude and estimated release volume. And,
most importantly, the release height can be entered, see exercise below. Do this for every release
area you wish to release. You can specify one release area, or multiple release area(s), see exercise

below.
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Exercise 3.5c : Specify release depth(s) and view release information

e Switch to 2D mode by clicking Ql
e Activate the project by clicking on the map once.

e Click on the View/Edit release area button & (1), choose Input = Release area... >
Details/Edit release area or right-click the filename and choose Release properties.

e Then click into the release area you want to get information on (2). A red polygon is
drawn around the selected release area. The following window appears:

Track Edit Input Show Run Results GIS Extras Project Help @

Fod m & o~ xow—»a@&m ANDoc¢e M EVE B@@ =

4| AVALANCHE

PARAMETER:

& € RAMMS | Release Info
) files  General Display Volumes Region
Release area information

Shapefiles, MuXi-Files and Domain-Files

Mean slope angle (%)

Wean atitude (mj):

Proj. area (m2):

Incl. area (m2):

1] M30_mu.asc (nput)
[18] M30_xdasc

main

; [E] Domain_dom.shp

[E] Marc_dom shp

[1[8] Shape_Domain_dom shp
[1[E] Test_dom shp input}

Release volume (m3f| 70147.51

Release depth d0 (m|

|

D Secondary

Cancel

< > < >

O % Eog B @ @ ES =% <

€ >

Click to edit and get info about release shapefile. (X 59340129 Y: 127800.74 Altitude (m): 2512 45

Figure 3-40: View/Edit release area

e Enter a release depth in the field Release depth dO (m). The corresponding release volume is
updated automatically.

e Additionally, the following release area parameter are shown: mean slope angle, mean alti-
tude, projected area and inclined (real) area.

e Arelease delay in (s) can be specified in the last line, see next Figure.

Remark: The estimated release volume is very accurate for the grid resolution of your input project.
If you calculate a different simulation resolution, the estimation can differ from the calculated re-

lease volume.

In Figure 3-40 we selected the northern-most polygon of the shapefile 3Rel.shp and assigned a
release depth of 0.5m.
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Let’s assign a release delay (secondary avalanche release) for one of the polygons in 3Rel.shp.

Therefore, we again click on i (1) and choose the middle polygon of 3Rel.shp (2), see Figure

3-41 below. We then specify a release depth of 0.3m and a delay of 10s (3).

Track Edit Input Show Run Results GIS Extras Project Help @

2 M8 o ROMeege D

~ 4 AVALANCHE

[0: v] AN Do ¢e M BVie @ee@

*
PARAMETER:
= @ RAMMS | Release Info
@ Fies  General Display Volumes Region
=) Release area information
@ Shapefiles, MuXi-Files and Domain-Files
Mean slope angle (°): -38.31 =423 Polyqon
o Li‘ - b‘f Rel chp
Mean attitude (m): EIE R =l
i || Z] Releaseshp
L [J1E) vdis_forest_all.shp
Proj. area (m2): [J/E _domshp
[J/E Marc.shp
| == (S
@ . %: { R M30_mu.asc (nput)
Z [J/E M30xdiasc
Ol Release volume (m3] 8 £ Domain
[E) Domain_dom.shp

0.30 o
@ Release depth d0 (m 0 o dam shp
@ O hape_Domain_dom shp

O ‘est_dom.shp (input)
10 ¢
@. [ secondary Delay (s): 0O s
[J/8 Shape_Domain.shp
Cancel OK
3) : .
® C
<
(Click to edit and get info about release shapefile. X: 593395.50 Y: 127204.72 Attude {m): 2360.04

Figure 3-41: About

We do not specify a release depth for the last polygon of 3Rel.shp.

In a next step we can specify a release height for one of the two polygons of shapefile 2Rel.shp,

see below.
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Track Edit Input Show Run

mE v

%

= o=

@ B Fiem<s «

<

©®¢ me® 8

<

XYZéoordihéteQ in lower ﬁgﬁ status bar

Results

@ RAMMS:: AVALANCHE 1.7.0 - [EARAMMS\AVALANCHE\Beispiele\Test\Test.av2] - O X

GIS Extras Project Help
X OMmeogelhm o ANOo ¢ M EVie 6w®

~ 4 AVALANCHE

PARAMETER:

Fies  General Display Volumes Region

Shapefiles, MuXi-Files and Domain-Files

“[][E] Releaseshp
[J[8 vdis_forest_all.shp
“[JE _domshp
“-[][8 Marcshp

£ MuXi
i [ & M30_mu.asc (input)
“[][8 M30_xiasc
main
[E) Domain_dom.shp

X: 595467.09 Y: 127430.40 Alttude (m): 1599.05

Figure 3-42: About

M| AVALANCHE

PARAMETER:

Files Display Volumes  Region

General

Volume and Release information

Release volume (m3)

Proj rel area (m2)

Incl rel area (mz2)

Release mass (t)

Density (kg/m3)

Edit release area

Figure 3-43: Release area and volume information

Additional release information is found in the Avalanche panel, tab Volumes, see Figure 3-43 above.
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3.5.2 Calculation Domain

To reduce calculation time, you can specify a smaller calculation domain to reduce the number of
computational cells. By analyzing a calculation with a coarse grid (large cell size), e.g. with a cell size
of 50r 10 m, you get an idea where the flow path is situated and you can limit the calculation domain
to the area of interest.

Switch to 2D mode and choose Input - Calculation Domain... = Draw New Domain or click e
Now you can draw a polygon containing the area of interest similar to drawing a new release area
(see section “Release area(s)” on page 38). We strongly recommend using smaller calculation do-
mains especially if you calculate with small cell sizes (e.g. < 5m).

1.280x10"

1.270x10°

/

1.265x10

1.260x10° [}

1.255x10" 2
2l
= -

5.935x10° 5940x%10° 5945x10 5.950x10" 5.955x10°

Figure 3-44: Calculation domain in green encloses the area of interest and reduces calculation time in
comparison with the default rectangular domain which is automatically generated.

44



CHAPTER Error! Use the Home tab to apply Uberschrift 1 to the text that you want to

appear here.: APPENDIX

Exercise 3.5d : Finding an optimized calculation domain

e Open yourinput file.
e Draw a rough calculation domain as explained above, see Figure 3-45 below.

Figure 3-45: Input file with big calculation domain

e Do a rough calculation with a simulation resolution of 10m. Use constant i and & values
of e.g. p=0.2 and £=2000.

e Wait for the simulation to finish. The simulation result will be displayed.

e Click the Max Flow Height button @

Figure 3-46: Max Flow Height of a 10m simulation with constant mu and xi

e Click GIS 2 Export... = Create Envelope Shapefile
e A question pops up: Use buffer?
e Click Yes. We want to use the envelope shapefile as a calculation domain, and therefore
we want to buffer it a little bit. Click No if you want to have the exact Envelope Shape-
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file of your output result. Beware: the MIN-value of your colorbar will be used as the
lower limit for the Envelope Shapefile!

Choose a filename for the envelope shapefile (a name is proposed).
The created envelope shapefile is shown in the visualization as a dashed red line.

Figure 3-47: Envelope shapefile of Max Flow Height extent

e Switch back to the input file E

e Use Input = Calculation Domain... = Load Existing Domain to load your envelope
shapefile as a new calculation domain, see Figure 3-48 below.

Figure 3-48: Input file with optimized calculation domain (envelope shapefile)

e Now redo your simulation with a simulation resolution of 5m and a MuXi-file.
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computational time.

3.5.3 Friction parameters p and §

Forest area

It is sometimes necessary to take forest areas into account, when running a simulation with variable
friction parameters (i and €). Beware: If your scenario is an extreme scenario, then it might not be
appropriate to use forest information, as a forest would be completely destroyed by an extreme ava-
lanche.

There are different ways to consider forest information:

(1) Import a digital forest file (ASCII grid or forest shapefile): Use Input = Forest... = Import
Forest from SHAPEFILE or Input = Forest... = Import Forest from ASCII Grid.
(2) Draw a forest file manually: See exercise below.

Exercise 3.5d: How to create a FOREST file

e Switch to 2D mode by clicking QI

e Activate the project by clicking on the map once.

o Click ¥ or choose Input = Polygon Shapefile... = Draw New Polygon Shapefile.

e Trace the forest outline by creating as many FOREST area polygons as necessary (pro-
ceed as in section “Release area(s)” on page 38) and name your new forest shapefile ac-
cordingly. The shapefile will be shown as a red dashed line in the GUI.

e Then right-click the shapefile in the Files-tree and choose Import forest from shapefile,
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see below.

Fles  Gemeral Display Volumes Fegion

Shapefiles, MuXi-Files and Domain-Files

=1-£5 Polygon

..... D @ profile shp

..... [1E] Release.shp

..... 1 E] secondrel shp
..... [E] Teest.shp (input)

Shapefile properties

Release properties

=14z Domain
D [E] Dorfb
[ [E] dom_dom shp finput)

Deposition analysis

Figure 3-50: Import forest from shapefile

e You are asked, if you want to import the created FOREST file into your project. Click yes,
if you want to use the newly created FOREST (ignore the next point in this case). Other-
wise click no and import the FOREST file later, as explained in the next point.

e Import the new FOREST shapefile: Choose Input = Forest... 2 Import Forest Area from
SHAPEFILE, then select your FOREST shapefile.

e This new FOREST information is not automatically taken over in existing MuXi-files.
Therefore, recreate existing MuXi-files if needed. If you create a new MuXi-file with In-
put = Friction Values... = Create new MuXi File (Automatic Procedure), the forest will
now be considered.
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MuXi-file

In RAMMS::AVALANCHE you can automatically generate a p and € file based on topographic data
analysis, forest information and global parameters. The following exercise shows how to create and
load MuXi-files for a RAMMS simulation with variable friction parameters.

Exercise 3.5e: How to create a new MuXi-file

e Choose Input = Friction Values... = Create new MuXi File (Automatic Procedure)

or click the button ﬁl

e A window pops up where you have to define an appropriate return period and check
your avalanche volume. You can also define these global parameters under (Input >
Global Parameters, see more information on page 20 ).

e In the following window (Automatic MuXi Procedure) you can enter a file name (op-
tional). If you leave it empty, then RAMMS will use a default filename, e.g. L30 (for
Large avalanche, 30-year return period). Unless you know better, leave the values as
they are.

@“ RAMMS | Automatic MuXi Procedure *

Volume = LARGE Return period = 30 Cancel OK

(Cptional: if empty -= default name}

MulXi name:

Altitude Limits {m.a.sl) 1: 1500

na

Above Altitude Limit 1

Open Slope - Mu: 0.170

Channelled Slope - Mu:

3000

.| 2000

Gulty Slope - Mu: 0.250

n

g

X X X X

Flat Area Slope - Mu: 0 .| 4000

3
3

Forested Area (mu=delta, xd=fix) - Mu: 0.020 | X

Below Altitude Limit 1

Open Slope - Mu: o| 2500

Channellzd Slope - Mu: 0.240 <| 1750

X X

Gully Slope - Mu: 0.310 - | 1350

.| 3500

Flat Area Slope - Mu: 0.170

X =

Forested Area (mu=delta, xi=fic) - Mu: 0.020

Below Altitude Limit 2

Open Slope - Mu: 0.210 - | 2000

Channellzd Slope - Mu: 1500

Gully Slope - Mu: 0.330 1200

Flat Area Slope - Mu: .| 3000

X ox o= ox X

Forested Area (mu=delta, xi=fic) - Mu: 0.020

HIEIE|E B EIE(E|EIE M EE|HIRE
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Figure 3-51: RAMMS Automatic MuXi Procedure.

e Click OK.

e If this is the first MuXi-file for this project, or if you changed or removed a forest cover
or if you changed the altitude limits when entering the file name, RAMMS will start a
terrain classification. Otherwise, RAMMS will skip the terrain classification (the classifi-
cation is saved in the file muxi_class.asc in the logfiles folder).

e The MuXi-file will be visualized after its creation. The pu- and €-values are saved in two
ASClII-files (L30_mu.asc and L30_xi.asc respectively). Only the region within the calcula-
tion domain will be visualized.

e You can switch between the release area (if already loaded), and the p and € values in
the choose Visualization area in the avalanche panel.

Exercise 3.5f: How to load an existing MuXi-file

e Choose Input = Friction Values... = Load existing MuXi File
e A window opens to browse for an existing MuXi-file.
e Click open and the file will be loaded.

3.5.4 How to run a calculation

To run a calculation you have to open a created project (section 3.3), load a release area (section
3.5.1), and a calculation domain (section 3.5.2). A MuXi-file is necessary as well. Below you find two
examples, one for running a constant calculation (constant release height and constant friction pa-
rameters W and §) and one for using variable friction parameters..

Exercise 3.5g: How to run an avalanche calculation

e To run a simulation choose Run - Run Avalanche Calculation or click ¥
e The RAMMS | Run Simulation window opens. Before clicking Run Simulation, you should
check the input parameters.

General Tab:

- SCENARIO Name

(1) Scenario output name: Choose a meaningful output filename, add parameter information to
the filename to recognize the output file.

(2) Save Max Values Only: If you want to save disk space and if the max values are all you are in-
terested in, then use this feature. After a simulation finished, all ASCII files (deposition, max
flowheight, max velocity and max pressure) are exported automatically. The simulation re-
sults cannot be visualized in RAMMS.

- Additional Information
(3) Project name.

(4) Project info: Add valuable project infor-
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mation to this field. € RAMMS | Run Simulation X
Params Mu/X Release
(5) Calculation domain. GENERAL SIMULATION INFORMATION
- SCENARIO Name
(6) Digital elevation info: Digital elevation [Test <— 1 |
model (DEM) file. [] Save Max Values Only ("_Max” will be appended to the output name} 4T

r Additional Information

: Stop Criteria Project name: Test «— 3

(7) Momentum stopping criterion, see sec-
tion 4.2.6 on page 72.

(8) Center of mass stopping criterion, see Calcuaton doman: | domain dom €— § I
4.2.6 on page 72.

Enter details here
Details: <+ 4

Digital elewation info: |Te5t.xyz <+ 6 | o =
- Remarks - Stop Criteria
(9) ”Escape” and “Ctrl+R” can be used to Percentage of total momentum (%): 7 4 7
cancel resp. start a simulation. Center-of-Mass vl threshold (mis): 7 <— 8

(10) Check box Run in background: Option | remarks
to run simulations in background mode, | U e Dokt isundon 4 — g
The RAMMS interface remains active
and allows the user to start e.g. new
simulations. Figure 3-52 General Information

10 B |:| Run in background Cancel RUN SIMULATION

51



CHAPTER Error! Use the Home tab to apply Uberschrift 1 to the text that you want to
appear here.: APPENDIX

Continuation of exercise 3.5g: How to run a constant avalanche calculation

Params Tab

- Simulation Parameters
(1) Sim resolution: Suggested simula-
tion resolution for large ava-
lanches: 5m. For small avalanches, | earameTers
you can try better resolutions, be-

| €

| General Mu/% Release

r Simulation Parameters

tween 2-5m. If your DEM resolution Sim resolution (m): (oeM: 2.00m) €— 1
is different than your simulation S <« 2
resolution, then RAMMS performs a N - i
ump step (s): .
bilinear interpolation. High resolu- Peien(®) 3
tion grids will extend your calcula- Density (kg/m3): «— 4 '
tion tlme - Miscellaneous Parameters I
. . . . stacle/Dam File: = 5 = .
(2) End time: Simulation end time. De- Spsiacilam Ll
fault time = 300s. Curvature @®on O off <+ 6
(3) Dump-step: The dump-step interval
defines the resolution of the anima-
tion of your simulation but has no
effect on the simulation results.
Suggested: 2-5s.
(4) Density: Keep the default value for
density if no further information on [ Run in background cancl RUN SIMULATION
the avalanche density is available
Figure 3-53: Parameter Tab
(300 kg/m?). g

- Miscellaneous Parameters
(5) Obstacle/Dam File: Draw polygons of areas, where no avalanche-flow should pass (houses,
deflecting dams, obstacles). The flow is then deflected.

(6) Curvature: Switch Curvature On or Off. Since Version 1.6.20, the normal force N includes cen-
trifugal forces arising from the terrain curvature. We use the method proposed by Fischer et
al. (2012) which was specifically developed for RAMMS. Typically, this increases the friction,
causing the flow to slow down in tortuous and twisted flow paths.

See https://www.ramms.ch/ramms-avalanche/friction-parameters/ for more information.
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Continuation of exercise 3.5g: How to run a constant avalanche calculation

Mu/Xi FRICTION PARAMETERS

(1)

()

(3)

(4)

Constant: For a calculation with constant
MuXi-values, click Constant. Enter p and ¢
values below. Choose Help = RAMMS Man-
uals... = Friction Parameter Table (PDF) or
see friction value table on page 101 for an
idea of pand €.

Variable: For a calculation with variable
MuXi-values (recommended), click Variable.
You should have created a MuXi-file before
starting a variable MuXi calculation.

Cohesion: For dry avalanches, values be-
tween 0-100Pa are ok (suggested: 50Pa). For
wet avalanches, slightly higher values (up to
200Pa) can be used.

See https://www.ramms.ch/ramms-
avalanche/friction-parameters/ for more in-
formation.

Define additional MuXi areas: You can spec-
ify up to two additional polygon areas where
you can change the MuXi-values. Make sure
you have good reasons to change the p and
€ values there.

RELEASE PARAMETERS

(1)

()

(3)

(4)

(5)

(6)

Filename: List of all the release shapefiles in
use.

Volume (m3): The estimated release volume
per shapefile is indicated in the second row.

Depth (m): Release depth per shapefile.
Delay (s): Release delay per shapefile. In
this example, the shapefile “secondrel.shp”

has a start delay of 10s.

Total Volume (m3): Sum of all the release
volumes from above.

Run Simulation Button

r Friction Values

| €

| General PXi Release

MUXI FRICTION PARAMETERS ‘?

Choose Mu/Xi Mode: OCunstant @Vﬂriabﬂ— 2
2000 K
1
0.:20
Cohesion (Pa} 3
Variable MuXi File
30 L | o= %

|:| Define additional MuXi areas

Shapefie 1 Shapefie 26— 4

|:| Run in background Cancel RUN SIMULAT

Figure 3-54: Friction values Mu and Xi.

€9 RAMMS | Run Simulation

General Params M SB

RELEASE PARAMETERS ‘?

- Release Information

______________________________________

Filename | i Volume tr'n:i] Depth [m) Delay (s)
11 1! 1] 1
1 1 1
Relasesrh | 1 7rsedl 108l 0B (@
FE g
| |__secondrelshpl | _12270.8411 _0.50_ 11000 4D
Total Volume (m3) 84029i58
\
5
6
|:| Run in background Cancel RUN SIN

Figure 3-55: Release information.
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Continuation of exercise 3.5g: How to run an avalanche calculation

Run Simulation
e Click run simulation (Figure 3-55)
e The following window appears, showing the status of the calculation (Figure 3-56)
General information of the simulation (1), output filename (2), starting the calculation (3), for
every dump step RAMMS outputs max flow height (Hmax) and velocity (Vmax) (4), moving
momentum (%, 5) as well as flow volume, outflow volume (if it exists) and numerical volume
loss.

Bl cmd.exe /¢ E\RAMMSWAVALANCHE'Beispiele\ Test\ Test.out.bat - m} X

ements and

8.8l m3

Figure 3-56: Calculation status window.
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output file: \Beispielel

o 4 o FI Press any button

Figure 3—57: Background simulation mode window.
Press any button to close the DOS window.

3.5.5 How to run BATCH calculations

If you want to start several simulations automatically (e.g. overnight) use Track > New... = Run
Batch Simulations. You can choose how many computational cores the Batch-Mode should use. It’s
even possible, to create a new directory for every single batch-simulation.

Please do the following to prepare input files for Batch-Simulations:

e Open an input file from your project, and open the "Run Simulation" window (the big green
button on the left vertical toolbar).

e Inthe "Run Simulation" window, go through all the tabs, and set all the necessary input spec-
ifications.

[" (this will close the "Run Simulation"

window), and then click the "Save Copy As" Button (or Track - Save Copy As), and save a

e Then, instead of starting a simulation, click "Cance

new input file (enter a meaningful name, .av2 file).

e Do the procedure above for every scenario you want to calculate. Then start the batch-
process and choose your input file. You can also choose input files from different directories
(projects).
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Track | Edit Input Show Run  Results GIS  Extras  Project  Help

Mew... » Project Wizard

Open... * Convert X¥7Z -> ASCIl Gnd

Close i Run BATCH Simulations

Save Ctrl+5 Run BATCH Simulation (from Folder)

save Lopy As Export ASCII Files from Simulations (Batch)
T Export ASCI Files from Simulations (frem Fo
Backup... »

Preferences Ctrl+P

Figure 3-58: Batch-Simulations
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4 Results

Once the simulation is finished, the simulation as well as the output logfile (see Figure 4-3) are
opened in RAMMS. (if you ran the simulation in background mode, see Figure 3-57, click any button
inside the DOS window to close the window. Afterwards, open the simulation in RAMMS manually).

125
Flow height (m)

Figure 4-1: Main window in output mode.

If the avalanche flows out of the calculation domain, RAMMS shows an alert (Figure 4-2). To get reli-
able results you should enlarge your calculation domain (see section 3.5.2).

OUTFLOW detected

.' . ATTENTION!!
QUTFLOW volume detected: 3.59 m3

Please enlarge your calculation domain!

Figure 4-2: Outflow volume alert.
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4.1 Project information

Once a scenario within a specific project is calculated, it is possible to open the output logfile (in out-
put mode) including project settings and information as well as calculation specifications. You can
open the project’s output log with Project > Output Log File. A window as shown in Figure 4-3
opens. This window provides information about your project and is the first thing to look at after
running a simulation to check your simulation results.

(1) Information on simulation time R Drosatsch | Stand o

File
and resolution. Be sure the i
RAMNS: AVALANCHE RANMMS OUTPUT LOGFILE

simulation stopped due to LOW
FLUX or CENTER of MASS. Oth-
erWise the OUtpUt TIME END Simulation stqppe_d aﬂe_rZ.DDDDDs 1
CONDITION informs you' that Real calculation time (min. ): 0.0655857

Simulation resoclution (m): 10.0000

Output filename: D:\Ramms\&valancheWorking_Directory\Drusatsch_test\Drusatsch.out.gz

Simulation stopped due to LOW FLUX! I

your simulation stopped before
SIMULATION RESULTS

the avalanche reached the
Number of cells: 13081

stopping criterion you defined Number of nodes: 13358 p)

for the Simulation (See SeCtion Calculated Release Volume (m3): 0.00000000 '_
Owverall MAX velocity (m/s): 0.000000

4.2.6 on page 72). Overall MAX flowheight (m): 0000000

Overall MAX pressure (kPa): 0.000000

)

(2) Information on simulation RAMNS::AVALANCHE 1.6.45 INPUT LOGFILE

results, Dvate: FriFeb 12 17:16:54 2016
Input flename: O:\Ramms\Avalanche\Working_Directory\Drusatsch_test\Drusatsch.avZ

m

Project: Drusatsch_test
Info: .

(3) Input logfile (see Figure 4-4).

DEM file: D:\Ramms\AvalancheWWorking_Directony\Drusatsch_test\iDrusatsch_test.xyz
DEM resclution (m): 2.00
(imported from: D:\Ramms\Avalanche\drusatscha_dtm2m. bt}

Nr of nodes: 850630
Nr of cells: 848718

Project region extent: r 3
E - W: 786898.00 / 784450.00
5 - N: 1880594.00/ 189458.00

CALCULATION DOMAIN:
Dr\RammstAvalanche\Working_Directory\Drusatsch_testicalc_doem_1.dom

GENERAL SIMULATION PARAMETERS:
Simulation time (s): 300.000

Dump interval (s): 2.00

Stopping criteria (mementum threshold) (%) 5
Constant density (kg/m3): 300

HUMERICS:
Numerical scheme: SecondOrder
H Cutoff (m): 0.000001

Figure 4-3: Output Logfile.
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The input logfile (included in the output logfile), however, can already be opened once a project is

created and before a simulation is performed.

There are two ways to view your project settings and information. First you can open your project’s

input logfile (or output logfile, in output mode), or you can check your project’s region extent and

area in the avalanche panel (region tab).

You can open the project’s input log file with
Project = Input Log File. The following window
opens:

This window provides information about all your
project’s input specifications, like number of
nodes and cells, release areas, which DEM was
used, the loaded map and orthophotos as well as
your global simulation parameters.

To view the project coordinates, click the region
tab in your avalanche panel. The region tab lists X-
and Y-Coordinates of the lower left (minimal val-
ues) and upper right (maximal values) corner (these
are coordinates you entered when creating the
project) as well as the global minimum and maxi-
mum altitude (Z value). Additionally, the total re-
gion area is shown (in km?).

File

RAMMS: AVALANCHE 1.6.23 INPUT LOGFILE -

Date: Mon Feb 29 15:24:25 2018
Input filename: D:\Ramms\Avalanche'Waorking_Directory\Drusatsch_testiDrusatsch.av2

Project Drusatsch_test
Info

DEM file: DRamms\AvalancheWWorking_Directory\Drusatsch_testiDrusatsch_test xyz
DEM resolution (m}: 2.00
(imported from: D:\Ramms\Avalanche\drusatscha_dtm2m.txt)

Nr of nodes: 850830
Nr of cells: 848718

Project region extent:
E - W. 786888.00 / 784480.00

S- N 188094.00 / 189485.00

CALCULATION DOMAIN
D:\Ramms\Avalanche\Working_Directony\Drusatsch_test\calc_dom_1.dom

GENERAL SIMULATION PARAMETERS:
Simulation time (s): 300.000

Dump interval (s): 2.00

Stopping criteria (momentum threshold) (%): 5
Constant density (kg/m3): 300

NUMERICS:
Numerical scheme: SecondOrder
H Cutoff (m): 0.000001

RELEASE:
D:\Ramms\Avalanche\Working_Directory\Drusatsch_tesf\igf_rep.shp
Release heights:

Release nr 0: 1.00m

Estimated release volume: 47252 m3

FRICTION MUX].

Altitude limit 1: 1500m a.s.1

Altitude limit 2: 1000m a.s.1

Format of follbwing parameters: [ <1000 ]-[1000 - 1500 ]-[ = 1500]

Figure 4-4: RAMMS Project Input Log file.

4 AVALANCHE

PARAMETER: Flow height (m)

Flee  General Display Volumes Region

Project region information

Xextent(m) | 5931545 |.| 5954445 |
' extent (m) | 1262775 H 1284275 |
Z extent (m) | 1376.3 H 2693.8 |

Proj area (kmz)

Figure 4-5: Region extent (X-, Y- and Z-
coordinates, total projected area).
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4.2 Visualization and analysis of results

This section gives a short overview on what is possible in RAMMS to view and analyze the simulation
results. The interpretation of the results has to be done by an expert who is familiar with the local as
well as with the topographic and meteorological situation of the investigation area.

RAMMS is a model and each model is a simplification of reality, therefore the simulation results
should not be analyzed without questioning them. We strongly recommend that all users perform
sensitivity studies.

4.2.1 \Visualize different parameters

The drop-down menu Results offers the following functions:

e Flow Height ®
e Flow Velocity

e Flow Pressure

e Flow Momentum

e Max values (Height @, Velocity \@l, Pressure I@', Momentum, Shear Stress)
e DEM Adaptions (Add Deposition to DEM)

e Flow Analysis (Summary of Moving Mass)

e  Friction Values (u, &)

e Cellarea (m?)

These results are all visualized by a color-plot in the topography. See exercise “4.2a Displaying calcu-
lation values” below.
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Exercise 4.2a: Displaying calculation values

The maximum values of flow height, velocity and pressure give a good overview of the dimension of
the avalanche. You find them under
Results - Max values...

— Max flow height
— Max velocity
— Max pressure

Figure 4-6: Results: Maximum values of flow height (left), velocity (middle) and pressure (right)

The flow height can be visualized exaggerated by a factor. Click Help = Advanced... <> Additional
Preferences... - Edit to change the factor of the quasi 3D-visualization of the flow height under the
keyword EXAGGERATION.

Figure 4-7: Quasi 3D-Visualization of flow height (left: exaggeration 1; right: exaggeration 5).
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4.2.2 Line profile and time plot

In the horizontal toolbar you find two further functions:

e Line Profile I

e TimePlot ©*

Line profile

A line profile is a good alternative to the color plot if the avalanche snow height, velocity or pressure
should be known at a specific location. The graph shows the currently active parameter. Every line
profile is saved in the file profile.shp in the project directory. If you want to keep this line profile, you
have to save it, see exercise “4.2b How to draw a line profile” below.

Time plot

This function provides a time plot at a single point. This is helpful when it is of interest to know the
values and maximum values at a specific location (e.g. at a building, dam, or a tree) through time.
Every point is saved in the file point.shp and a point-info file point_info.txt is additionally saved in the
project directory. If you want to keep this point, you have to save it, see exercise “4.2c How to create
a time plot” below. The point-info file can be visualized with Extras = Point... - View Point Info File.
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Exercise 4.2b: How to draw a line profile

a) Draw a new line profile:
e Switch to 2D mode by clicking Q‘

e Activate the project by clicking on it once, then click I or choose Extras - Profile - Draw
New Line Profile

e Define the line profile in the same way you specify a new release area. Finish the line profile
with a right-click on the mouse button.

e A window opens, displaying the line profile.

[ — 1780
26 — 1760
20 - —{ 1740
s ot 1
= B — 1720 o
[®)]
frep 12
8 — 1700 <
: — 1680
05 ]
r — 1660
004 20 40 60 )
Proj. Distance (m)
Figure 4-8: Line profile plot.
— Filled grey area active parameter (scale on left side).
— Redline active parameter (multiplied by 50) added to the track
profile (altitude, scale on the right side).
— Black line track profile (altitude, scale on the right side).
— Bottom scale projected profile distance (in m).

e If you change the active parameter, min or max values or the dump-step in RAMMS, the plot
is directly updated. You can also start the simulation and then watch the time variations in
your line profile plot.

e |t makes sense to either draw a profile line perpendicular to the flow direction or draw the
line along the flow path. Basically, every imaginable path is possible
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Continuation of exercise 4.2b: How to draw a line profile

T | TTT ‘ TTT | TTT | T 1T | T 1T ‘ T 3
1650 4 _é oo
E = E —= 1800 =
= = = 3 =i =
=) 1600 2 = E :
g = '5 g E 1700 E
z 7 = z 2 = =
8 — 1550 < o —= 1600 <
[T = L =
3 1 E
— 1500 5 1500
Il 111 | 111 ‘ 11| | 11| | 111 | 111 ‘ $
100 2(:_'0 _ 300 400 500 00 200 400 600 800 1000 1200 1400
Proj. Distance (m) Proj. Distance (m)
Figure 4-9: Line profile perpendicular Figure 4-10: Line profile along
to flow direction. the flow direction.

e To save the coordinates of the points belonging to the line profile, go on Extras - Profile - Save
Line Profile Points and enter a file name.

e To save the line profile parameters (distance in m and the active parameter, e.g. the flow height in
m) at the current dump-step, go on Extras - Profile - Export Profile Plot Data and enter a file
name.
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Continuation of exercise 4.2b: How to draw a line profile

b) Load an existing line profile:
e Switch to 2D view by clicking QI

e Activate the project by clicking on it once and click I or choose Extras -» Profile - Draw
New Line Profile

e Click the middle mouse button once

e A window pops up and you can browse for the line profile you wish to open

Exercise 4.2c: How to create a time plot

a) Select time plot point:

e Click " or choose Extras > Point - Choose Point

e C(lick into the map at the point where you want to create a time plot.

e A window opens, displaying the time plot at the point of interest (active parameter vs. time).
Flowheight is always combined with Velocity, whereas Velocity, Pressure or Momentum are
always combined with Flowheight.

B RAMMS Time Plot - O X
Sirmulation: Test_ COM
4 — — 30
- - Flow height N
[ ™ v, |7~ — Velocity [ 25
3 N
- = — 20
E = N )
3 .
T 2= — 15 %
= = e
3 C -3
- C — 10
1 N
- “wo~. 5
0 = - | L1 1 |f L1 1 I - t l _ O
0 20 40 60 80 100 120
Time (g)
HH@v|%\gnv[[hv - - - - - [140,348]

Figure 4-11: Time plot window.

e To save the point coordinates, choose Extras - Point - Save point Location and enter a file
name

e To save the time plot data (time in s and the active parameter, e.g. the flow height, for every
dump-step), choose Extras - Point - Export Point Plot Data and enter a file name.
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Continuation of exercise 4.2c: How to create a time plot

b) Load a time plot:
e To reopen the time plot graph window of the last selected point, go on Extras = Point =
Create Point Time Plot
e To open an arbitrary time plot that was saved any time before, click .
e Click the middle mouse button once.
e A window pops up and you can browse for the time plot file you wish to open.

c) Enter point coordinates and get a time plot:
e Go to Extras - Point - Enter Point Coordinates (X/Y)
e Enter X-coordinates of your point of interest. Click OK.
e Enter Y-coordinates of your point of interest. Click OK.
e The time plot opens.

4.2.3 Deposition analysis
A deposition analysis (flow height) for a region of interest (ROI) can be done in the following way:

e right-click the shapefile you want to analyze
e choose Deposition analysis
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& RAMMS::AVALANCHE 1.7.0 - [C:\Users\christem\RAMMS\Beispiele\Avalanche\VdIS\VdIS.out.gz] -0 “
Track Edit Input Show Run Results GIS Extras Project Help

I ESEE W& o ROk m 1y ANDOGe U FVie 000 k Bo Ee

o\ °\° 4 AVALANCHE

B " o L
* o ¥
¢b PARAMETER: Flow height (m) 2
@ Fies | General | Display | Volumes | Region
g Shapefiles, MuXi-Files and Domain-Files
o
b
»
(@l
®
@\
@
B
3> &
® ’
Time (s): 90.00
< >
XYZ-coordinates in lower right status bar X: 595397.65 Y: 126923.24 Altitude (m): 2959.98 Flow height (m): 0.00

Figure 4-12: Deposition analysis of region of interest.
& Deposition Analysis - VdIS.ocut.gz

Save | Save As... || Close
Deposition Analysis
Output Filename: VdIS.out.gz
Shapefile Name: deposition shp
Time: 90.00s

Flowheight Analysis
ITota\ deposition volume: 34438.70 m3 I

Min flowheight: 0.00 m
Mean flowheight: 0.873 m
Median flowheight: 0.567 m
Max flowheight: 5.64 m

Nr data values: 1435

Figure 4-13: Result of a deposition analysis. Total deposition volume (m?3)
as well as some statistical values are shown (min, mean, max).
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4.2.4 Google Earth Export

You need to have the Google Earth Software installed on your PC/laptop, otherwise you cannot use
this feature. The use of Google Earth is for free.

It's possible to export your result to Google Earth. The default settings are for Switzerland. If your
project region is within Switzerland, you are lucky, and all you have to do is visualize the result you
want, and then using Extras - Google Earth... - Export Result to Google Earth.

Image © 2022 Maxar Technologies
Image Landsat / Copernicus

-

-

Figure 4-14: Left: Visualization in RAMMS; Right: Exported result in Google Earth (© Google Earth)

If your project region is not within Switzerland, then the following other projections are supported in
RAMMS:

e UTM
e State Plane

Click Extras - Google Earth... - Google Earth Option to open the following window:
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€% RAMMS Map Opticns X

- Projection

For UTM, the zone number should be in the range
of 50 to -1 (Southern Hemisphere) or 1 to 60
(Morthern Hemizsphere).

Projection: | Switzerland 32 7
Beszel 1841
- Projection Parameters
0.00040
0.0004
0.00040
0.00040

- Google Earth View Parameters

Wiew distance (meters): 2000.0

Inclination (degrees): 45

(0% wertical | 20°:horizontal view )

Rotation (degrees): III

{0°:N | 90:E | 180°:S | 270°:W)

Cancel OK

Figure 4-15: Google Earth Options. Choose Projection and Spheroid (Datum) of your project region

If you choose a UTM-projection, then it’s possible to set the parameters in the Projection Parameters
section. The section Google Earth View Parameters are parameters for the initial visualization in
Google Earth. Change them as you like.

The Figure below shows the drop-down menus for the Projection and the Spheroid (Datum) fields.
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Projection:

Spheroid:

UM

St

Spheroid:

Bessel 1841

ot

Clarke_1386
| Pra-jec:tion H C-|ﬂrkf.‘_1 &30
Bessel 1841

Center Lat
Center Lon
Semimajor

Semiminor

- Google Eart
View distd

Inclination
(0% wertical

Fotation (d

Switzerland {0°:N | 90°:H
UTM
STATEPLANE

International 1567
International_1909

WGESs_ 72

Ewerest

WGS5_66

GRS_1930

Airy

Modified_Everest
Modified_Airy
Walbeck
Southeast_Asia
Awustralian_National
Krassovsky

Hough

Mercury_1960
Modified_Mercury_1968
Sphere

Clarke_IGN
Helmert_1906
Modified_Fischer_1960
South_American_15%65
WGES_1024

i

Figure 4-16: Google Earth Projection and Spheroid (Datum) drop-down menus

Click the Help-Button

anc

Projection Parameters (only for UTM), such that your result is visualized correctly.

to get help about the projections and how to specify Zone, Spheroid and
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4.2.5 Creating an image or a GIF animation

Image

It is possible to export your results as an image in different formats (e.g. .png, .jpg, .gif, .tif etc.).

Click i‘.’l or choose Track - Export... - Image File and define a file name with the corresponding
extension. An image of the visible part in the viewer will then be exported.

GIF animation

Creating a GIF animation is only possible in output mode. Click @ or choose Track - Export... - GIF
Animation. Enter a file name and location and wait until the simulation stopped. As soon as the sim-
ulation finished, the GIF animation file is saved. In the Preferences in the avalanche tab you can de-
fine the interval for the GIF animation (GIF animation interval [s]).

4.2.6 Stopping criteria
There are two stopping criteria available in RAMMS:

1. Standard stopping criterion: Momentum-based, “Percentage of total momentum (%)”
2. New stopping criterion: Center-of-mass based, “Center-of-Mass vel threshold (m/s)”

Stop Criteria

Percentage of total momentum (% ): ?
Center-of-Mass vel threshold (mis): ?

Figure 4-17: The two stopping criteria available in RAMMS

The stopping criteria can be changed when starting a new simulation, see also Figure 3-52 on page
51. You can define both stopping criteria, and the simulation will then stop when one of them is
reached, either the momentum- or the center-of-mass-criterion. In the following, both criteria are
explained in more details.

Momentum-based stopping criteria

In classical mechanics, momentum p (S| unit kgm/s, or, equivalently, Ns) is the product of the mass
and velocity of an object (p = mv). Threshold values between 1-10% are reasonable, but this is only a
suggestion and has to be empirically determined for each test case. For every dump-step, RAMMS
sums up the momenta of all grid cells (dump-step-sum), thus finding a maximum momentum sum
(max-momentum-sum). Then the dump-step-sum is compared to the max-momentum-sum. If this
percentage is smaller than a user defined threshold value (see Figure above and on page 51), RAMMS
aborts the simulation and the avalanche is regarded as stopped.
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Stopping criteria with large threshold values (e.g. >10%) may result in unrealistic early stopping of a
simulation. Small threshold values however may lead to numerical diffusion of the simulation results
and very slow creeping of the avalanche material and velocity oscillations.

To check the stopping of your simulation, click Results = Summary of Moving Mass. A window simi-
lar to Figure 4-18 opens which shows the summary of moving mass.

—————
€5 Moving Mass & Momentum Analysi T 5] Moving Mass & Momentum Analysis - H— (o]
-
HOVING WASS 100,00 (e ¥ng Momentum
The stopping erteria in RAMMS is based on the momertum. In classical mecharics, momentum s the product of the mass and velocity of an object {p = T T T ]
my) = F 1
For every DUMP STEP, we sum the momenta of al gnd cells, and compare it wih the mazdmum momentum sum. f his percentage is lower than 2 user £ 8000 3
defined threshold value (see below). the program is aborted and the avalanche is regarded as stoppe: P F 1
@ F 1
Threshold values betwezn 1-10% are reasonable, but this is only = suggestion and must be validated by the individual user Himseff o 6000 -
o E ]
- o 3 -
Time (s) Flow Volume (m3) Max Momentum {m2/s) Flow Momentum {m2/s) Percent % | g 40.00 (- 1
220000 206604 126250 126250 100000 . H £ ]
4.20000 205604 212580 212580 100000 £ 2000F E
6.10000 205604 259990 2599.90 100000 Focoooo mm=== q==ro== — ]
pop BT oo T il ftili Nl T
8.10000 205604 287090 287090 100000 ) 50 100 150 200
10.1000 205604 2966.30 2966.30 100.000 Time (S)
120000 205604 2966.30 292550 98,6000
14.0000 205603 2966.30 2786.40 939000 Flow Volume
16,1000 205603 2966.30 265260 83.4000 2100000 T | T T T T T3
18.1000 205603 296630 254840 85,9000 . E E
20.1000 205603 296630 242870 815000 2 2050000 E E
20000 205602 2966.30 233250 78,6000 T 20000.00 [ E
24.0000 205602 2966.30 22550 75.0000 £ E 3
26,0000 205602 296630 208820 704000 2 1950000 E
28.0000 205601 2966.30 1947.30 65,6000 > E E
30.0000 205601 2966.30 1849.40 623000 H 1900000 £ E
321000 205601 296630 1788.20 602000 T 1850000 S
341000 205600 296630 172830 58.3000 E | | | E
36,2000 205600 296630 167160 56,4000 1800000 7 50 T00 150 200
38.2000 205600 2966.30 1619.90 54,6000 Time (&)
40.2000 205599 2966.30 1567.30 52,8000 =
S2 det [ 7,
d b = Fl (52 EE’ A A~ [97,507]

Figure 4-18: Summary of Moving Mass information windows

Whether or not an avalanche stops depends on terrain (slope angle in runout), total flow volume and
friction values and should always be evaluated by an expert. In case of doubt on how to choose
threshold values we recommend running a simulation with a 1% threshold and checking the sum-
mary of moving mass for numerical diffusion and analyzing the avalanche runout (flow height and
flow velocity) with time plots (section 4.2.2).

threshold: 0% threshold: 1%

RAMMS: AVALANCHE Time Plot - Velocily (mys)

=T I T | T I T | T T I | T I I | T T I —
0.6 [— -+
7 | |
£ r |
= D4 — i
Z B N
o
[§} — —
=
02— i
n A
[ oo | | 1 | | | | | | | | | | | | | | | |
2 000 050 100 150 200 250 300 0 200 400 ) 600 800 1000
: Max height (m) Time (s)

Figure 4-19: Stopping behaviour of a RAMMS simulation. Small threshold values may lead to unlikly slow
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creeping of the material. In the example shown in the figure above the stopping criteria is set to 0%.

0% 1% 3% 4% 5% 10% 15%

1257

€. 000 050 100 150 200 250 300 "
/ Max height (m)

b
t‘; / 1
| !
W/ Y/
’2% \ Bethleheml ) 7"2(1 \ Bethlehem
. 1 .l

Figure 4-20: Stopping behaviour of a RAMMS simulation. In this example threshold values <2% lead
to numerical diffusion of the simulation results. Threshold values between 3-5% seem to be
appropriate in this case.

Check the output logfile under Project - Output Logfile to verify your simulation stopped due to low
flux (see Figure 4-3 on page 59). Otherwise enlarge the end time of your simulation (see exercise
“Run a calculation” on page 50).

Center-of-mass stopping criteria

This stopping criterion was introduced in Version 1.8.0. The idea of this new stopping criterion is the
following: Following the center-of-mass (COM) of the flow. RAMMS is calculating the COM every 2s,
and from the covered distance the velocity, with which the COM is moving.

The user can define a velocity threshold (in m/s), see Figure 3-52 on page 51, and as soon as the COM
is moving slower than this threshold, RAMMS considers the flow as stopped. With this approach,
numerical diffusion and slow creeping movements at the front can be prevented.

This criterion should only be used, if you simulate one single avalanche problem (catchment). If you
define two or more release areas (for different catchments), then this approach makes no sense. In
this case, set the threshold value to zero. In any case it’s suggested to do simulations with and with-
out the center-of-mass stopping criteria, and to critically analyze results.

During a calculation, the center-of-mass travel-speeds are also written to the standard-output (the
black DOS command prompt), see Figure below. You can open the standard-output-logfile with
Extras -» View Simulation Standard Output Log.
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Figure 4-21: Center-of-mass travel speeds
4.3 Adding structures or deposition to DEM

The option to adding structures or deposition to DEM must be used with great care and should not
be used to design deflecting dams. Deflecting or catching dams can neither be designed directly with
RAMMS nor can the residual risk below dams be calculated directly with RAMMS. RAMMS takes im-
portant factors in dam design such as energy dissipation, dam geometry or snow deposits in front of
a dam not properly into account. Dams have to be designed using well known standard engineering
procedures, e.g. Johannesson et al. 2009 [1], Rudolf-Miklau and Sauermoser 2011 [2]. RAMMS is well
suited to calculate the key input factors for dam design such as flow height and velocity. The dam-
option should however only be used to try to visualize the influence of guiding or small deflection of
the avalanche mass. RAMMS cannot be used directly to evaluate if the height of a deflecting dam is
sufficient for a certain scenario or not (see explanations below).

4.3.1 Creatingadam

RAMS offers the possibility to simulate the presence of a deflecting dam by increasing the altitude at
the position where a dam is considered. This option helps the user to design mitigation structures
and to test its influence on potential flow paths near populated areas.

Exercise 4.3a: How to create a new DEM to simulate a dam

e Create a polygon shapefile where a dam is supposed to be built (Figure 4-22).

e Create a second, inner polygon, if you wish to have a two-stage dam.

e Goon GIS 2 Add DAM to DEM...
You have two options... = Enter Relative Dam Height or ... 2 Enter Dam Elevation

e You will be asked to “Open dam file (*.shp)”. Select the shapefile you want to use as the out-
er edge of the dam.

e The question pops up, if you want to “Open 2" dam shapefile (inner polygon)?”
—> Click No to continue with the next step
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- Click Yes to choose a 2" dam file (*.shp).

o Next step is to enter the total elevation height or the total relative height of the dam in me-
ters. This is the elevation of the dam crest.

e If you loaded an outer polygon file, you will be asked to enter the intermediate height (m)
(height of the outer polygon file) as well.

e Finally, you have to “Enter new XYZ name”. Your new XYZ-file with the topographic infor-
mation, containing the “dam”, is created in your project directory.

TG IITIE 2,
51:":’11’1' L7

ZZA2
S
L A T TA

Figure 4-22: Polygon area where a dam is Figure 4-23: New DEM with dam at location
supposed to be built. of polygon shapefile.

To run a simulation based on the newly created XYZ-file, all you have to do is to choose the new XYZ -
file in the Run Simulation window, see below:
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€ RAMMS | Run Simulation *

General  Params Mu/ Release

‘GENERAL SIMULATION INFORMATION

QUTPUT Name
Test

Additional Information

Project name: Test2

; Test project
Details:

Calculation domain: | dom.dem |
Digital elevation info: | Test2 xyz |

| Select XYZ file
Stop Parameter

Percentage of total momentum (%)

Remarks
- use "Escape” to close/cancel this window
- use "Ctr+R" to start a simulation

|:| Run in background | Cancel | | RUH SIMULATION |

Figure 4-24: Select new XYZ-file with dam information.
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Dam, height 50&1
Figure 4-25: Simulation without (left) and with (right) a dam.

While RAMMS is able to simulate the effect of a dam lying lateral to the direction of flow quite well,
there might occur numerical problems if a dam lies perpendicular to the direction of flow.

e Because there is no energy dissipation due to collision with dams implemented in RAMMS,
unrealistically large flow velocities and flow heights may be simulated in front of a dam.
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e The numerical solver used in RAMMS incorporates information from neighboring cells. The
effect of dams with only one

cell as dam side wall may there- ';.",;n,'-,:.:,:,:,:i,:,"’! v
orre . L7 v, L]
fore be difficult to simulate. '::Z,."':"""':if.'.":,'l}.i,z../yg Y
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If you encounter problems with the L 2
= 77

simulation of mitigation measures as
described, we suggest creating a DEM

including a dam in GIS, ideally using
progressively increasing side walls as shown in Figure 4-26.

The interpretation of RAMMS simulations including mitigation measures such as dams has to be
done by experts. In addition, we recommend to always check the simulation results with engineering
approaches.

4.3.2 Creating a new DEM with avalanche deposition

In case you wish to simulate an avalanche overflowing a previous avalanche, you should consider the
deposition of the previous avalanche, because the path of the second avalanche will be influenced by
the modified terrain. In RAMMS one has to assume that the deposits from an initial avalanche are
not entrained by a subsequent avalanche. To do this, in the output mode, users can select the option
Add Deposition to DEM to add the flow height of an avalanche to the DEM at any arbitrary dump-
step. A new xyz-file (with the updated topographic information) will be created.

Exercise 4.3b: How to add avalanche deposition to new DEM

e The deposition height is the flow depth at the end of a simulation when the avalanche is
considered to have stopped moving (alternatively, earlier dump-steps may be used if there
are reasons to believe the flow should have stopped earlier). So first view the results at the
last time step or a different time step, if desired.

e Go to Results =2 Add Deposition to DEM

e Enter a new name for the new XYZ-file.

e The new XYZ-file, containing the deposition information, is created. To run a simulation
based on this new XYZ-file, just choose the XYZ-file in the Run Simulation window, see Figure
4-24,
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5 Program overview

RAMMS is a windows-based program that relies on drop-down menus and dialog boxes to set the
model parameters, run calculations and view results. Toolbar buttons are also available and provide
short-cuts of the menu path; moving the cursor over a button results in a short explanation, appear-
ing in a text box below the cursor (‘tooltip’). For functions not available in the current context, the
menus and buttons are deactivated and cannot be used.

5.1 The Graphical User Interface (GUI)

The graphical user interface (GUI) consists of menu bar, horizontal and vertical toolbar, main win-
dow, time step slider, right and left status bar, colorbar and panel, see Figure below. They will be
explained in the following sections.

@' RAMMS: AVALANCHE 1.70 DEV - [EARAMMS\AVALANCHE Beispiele\Test\Test_COM.out.gz] - O X
Track Edit Input Show FRun Results GIS Extras Project Help
SEE W& o O em 2 ANDoc¢ce M EVE @0@e k o He
4| AVALANCHE
&
PARAMETER: Flow height (m)

» 5.00

) r MIN/ MAX | COLORS r TRANSPARENCY / CONTOURS —

E WAX o Transparency % o

i < >
&
MIN

] L Simulation Contour Lines
COLORS Li] @ ¥ @

s -

E‘ 1.70 r Various

- Files  General Volumes Region
3 o088
r Shapefiles, MuXi-Files and Domain-Files
@® 005
+ C
& =423 Polygon
e i [E domain.shp
O @ Release shp
~[_]/&] secondrel.shp
~[]/8] profile shp
-0 MuXi
-7 Domain
b3l Time =54.00s
< >

®©

E4

Time (8): 54.00

<

Click & drag or use amow keys [614,281]

Figure 5-1: Graphical user interface (GUI)
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5.1.1 The menu bars

Track

Similar to the Microsoft Windows File menu, Track is used to open, close, save, print, backup and

export files.
New... Project Wizard Start a new project, guided by the wizard (Ctrl + w) xl
Convert XYZ Data > Convert regular or irregular XYZ data (e.g. laser scanning data) into
Raster Data a raster grid (ESRI ASCIl or GEOTIFF).
Run BATCH simula- Possibility to start simulations au.tomatlcally (e.g. overnight) You
) can choose how many computational cores the Batch-Mode
tions should use (quasi parallel simulations, saves computational time).
R.un BATCH simula- Choose a folder with input files for a batch simulation (see above).
tions (from Folder)
Export ASCII Files ) . . )
. . Automatically export all ASCII files (max height, max velocity, max
from Simulations L . !
pressure, deposition) from multiple output files.
(Batch)
Export ASCII Files ) . . )
. . Automatically export all ASCII files (max height, max velocity, max
from Simulations L )
pressure, deposition) from all output files from a folder.
(from Folder, Batch)
Open... Input File Open an existing input file (*.av2) (Ctrl + O) ﬁ‘vl
Avalanche Simulation  Open an existing avalanche simulation (*.out.gz) (Ctrl + A). [ﬂl
Close Close active file (input or output) .I
Save Save active file (Ctrl +S)
Save Copy As Save a copy of the active file (e.g. test.av2) under a new name (e.g. gl
Py simulationl.av2, works only in input mode).
Create an image of the active window in a chosen format. You can
Export... Image File choose the desired image format using the file extension (e.g. @I
.png, .jpg, .gif, .tif, etc.).
. . Create a GIF animation (only in output mode). Change GIF anima-
GIF Animation e ( v P ) & ﬂl
tion interval (s) and delay (s) in the preferences.
B
Backup... ackup RAMMS Make a backup of the current RAMMS Version.

Version

Backup Active Project

Backup your active project. The user will be asked if he/she wants
to include output files in the backup. This function is useful when
having problems with a simulation. Make a backup and send the
zip-file together with some explanations to support@ramms.ch.
Make sure that all your input data (release area shapefiles, do-
main files, etc...) is in the project folder.

Backup User Defined
Files/Folders

Backup any folder or files you want.
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Preferences

Change RAMMS preferences (Ctrl + P) I

RAMMS Logfile

Log files...
og files (current)

Show active RAMMS logfile.

e RAMMS Logfile
(last session)

If RAMMS crashed, open this logfile and copy/paste the content
into an email to support@ramms.ch.

Restart RAMMS

Restart RAMMS.

Exit Exit RAMMS (Ctrl + Q).
Recent... Shows a list of up to 10 of your recent input and output files.
Edit

This menu is used to edit colorbar, axes and dataspace properties.

Colorbar Properties Edit the colorbar properties. |
Get Colorbar Get back your colorbar, if lost.
Dataspace Properties Edit your dataspace properties. |

Show Dataspace Axes

Shows or hides dataspace axes of the project region. The axes are only visible if the
background color is NOT set to black.

Colorbar White Color Checkbox. If checked, the colorbar text-color is white (default), otherwise black.
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Input

Menu used to specify global parameters, calculation domain, release area, friction parameters and

forest cover. This menu is active only in input mode.

Global Parameters

Set return period and avalanche volume. These parameters
are used to calculate a friction MuXi-File.

Draw a new calculation domain. The mouse cursor changes to
an arrow. Select points with the left mouse button, finish with

Calculation
D . Draw New Domain a right mouse button click (the final right mouse button click is @l
oman... NOT a point of your calculation domain). This works only in 2D
mode. Choose points clockwise.
L. . Load an existing calculation domain (*.shp). Any polygon
* Load Existing Domain shapefile can be used as calculation domain (Ctrl+D).
This activates the button to draw new polygon shapefiles. The
mouse cursor changes to an arrow. Select points with the left
Polygon e Draw New . . . . )
sh fil Pol sh fil mouse button, finish with a right mouse button click (the final
apetile... olygon Shapetile right mouse button click is NOT a point of your polygon). This
works only in 2D mode. Choose points clockwise.
* Load Existing . Load an existing polygon shapefile.
Polygon Shapefile
. . The mouse cursor changes to an arrow and you can select a
Release e Details/Edit Release ) )
A A release area to define the release depth and to view release 4?
rea.. reas area information. This works only in 2D mode.
e Details/Edit Overl
etails/Edit Overlap Same as above, but used for overlapping release areas.
Release Areas
e Show Active Forest If forest is con5|de|jed, the corresponding shapefile is dis-
Forest... C played. If your project uses no forest cover at the moment,
over RAMMS will tell you so.
e Import Forest Area . ) . . .
You can import any polygon shapefile using this function.
From SHAPEFIL
e Import Forest Area If a forest ASCII grid is available, it can be imported using this
From ASCII grid function (0 = no forest, 1 = forest).
e Remove Active Forest . .
Remove the active forest raster data from the project.
Cover
Friction isti i
* L?ad an Existing MuXi Load afore created MuXi-file (*_mu.asc or *_xi.asc).
Values... File

Create New MuXi File
(Automatic Procedure)

The DEM is analyzed, classified and according to altitude,
slope and curvature information, return period and avalanche HI
volume, a new MuXi-file is created.

Show MuXi Classifica-
tion

Shows the result of the MuXi-classification.

Advanced... 2 Remove
MuXi Classification File

Remove the MuXi-classification file.
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Show

This menu enables and disables the different visualizations. A little arrow indicates if the visualization
is enabled or disabled.

Show Lights Show/hide light effects _ﬁj_}J
Show Grid Show/hide computational grid E
Show Map Show map E
Show Image Show orthophoto/image iﬂ]
Show Visualization Show/hide release area (input mode) or simulation results (output mode) @
Show Arrow OUTPUT | Show/hide point arrow of time plot

Show Colorbar Show/hide colorbar E‘
Show Velocity Arrow OUTPUT | Show/hide velocity vectors \'h
Show Domain INPUT | Show/hide calculation domain

Run

This menu is active only in input mode.

Run Avalanche Calcula- Opens the Run Simulation window to change parameters and to start the calcula- @
tion tion of an avalanche simulation (F8).

"’i,
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Results

This menu contains the results functions and is only active in output mode.

Flow Height

Shows flow height of the avalanche every dump step.

Flow Velocity

Shows flow velocity of the avalanche for every dump
step.

Flow Pressure

Shows flow pressure of the avalanche for every dump
step.

Flow Momentum

Shows flow momentum of the avalanche for every
dump step.

Max Values... °

Max Flow Height

Displays the maximum flow height.

Max Velocity

Displays the maximum velocity.

Max Pressure

Displays the maximum pressure.

®@@@

Max Flow Momentum

Displays the maximum momentum.

Max Shear Stress

Displays the maximum shear stress.

Add Deposition to DEM

Adds the deposition of an avalanche simulation to the
DEM. A new DEM file is created.

Summary of Moving Mass

Summarizes the Moving Mass.

Mu Displays the friction parameter p for this simulation.
Xi Display the friction parameter § for this simulation.
Grid Cell Area Display the grid cell area for each grid cell (m?).
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GIS

This menu contains miscellaneous GIS functions.

Add Data

Add data (shapefiles, MuXi-ASClI files) to the visualiza-

tion.

o

Export ... e Result as Shapefile

Export the active result to an ESRI GIS shapefile for
later use in a GIS program.

e Result as Raster Data

Export the active result to a GEOTIFF (default) or ASCII

raster file..

e Envelope Shapefile

Create an envelope shapefile from the active result.

e Envelope Shapefile from
ASCII File

Create an envelope shapefile from an ASCII file. User

can specify an ASCII file (e.g. max flow height).

Add Dam to DEM

Adds a dam to the DEM. You have to specify rel-
ative dam height or absolute dam elevation.

Show Slope Angle (°)
Show Curvature (1/m)

Show Contour Plot

Display the slope angles.
Display the curvatures.

Display a contour plot.

B |< pat

Resample Slope/Curvature

Resamples slope/curvature plots to a user de-
fined resolution.
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Extras

Add/Change or Remove map

Add/Change or Remove Image

Add or change the topographic map of your pro-

ject. The maps can be located in your project di-
rectory, or in your distribution’s ‘Map’ folder, EJ
see section 3.2 for details. If not, you can browse

for maps.

Add, change or remove the image used for visu-
alization of your project. The images can be lo-

cated in your project directory, or in your distri- &)
bution’s ‘IMAGE’ folder, see section 3.2 for de-

tails. If not, you can browse for images.

Create Hillshade Image

This will calculate a hillshade visualization of
your DEM. It’s then saved as a TIFF image that
you can use in RAMMS.

Point ... e Choose Interactively

e Enter Coordinates (X/Y)

This activates the button to select a point. The mouse
cursor changes to an arrow. Select the point with the ~ 4—#
left mouse button. This works only in 2D mode.

Enter the coordinates of a point you are interested in.

e Create Time Plot

e View Info File

Create a time plot of a selected point. E

View point info file.

e Save Point Location

e Export Time Plot Data

Save point location as a point shapefile.

Export time plot data as a txt-file.

Profile ... e Draw New Line Profile

This activates the button to draw a line profile. The

mouse cursor changes to an arrow. Select the points of

the line profile with the left mouse button, finish with &
a right mouse click. This works only in 2D mode.

e Save Line Profile Points

e Export Line Profile Plot
Data

Save your line profile as a polyline shapefile.

Export the line profile plot data as a txt-file.

Save Active Position

Reload Position

Save your current state of view, as well as the
enabled and disabled visualizations.

Reload your saved position.

e Export Result to Google

Google Earth ...
g Earth

e Map Options

e Map Options Help

This function exports release areas and your results to
Google Earth. If your project location is within Switzer-
land (default), you can use this function without
changing any parameters. If not, see Map Options.

Enter map options if you want to export your result
from a location outside of Switzerland

Get help about Google Earth Map Options.

View Input File

Opens the input file in a window.

View Simulation Standard
Output Log

Opens the simulations standard output log in a
window (the black DOS window you see when a
simulation is running).
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Project

This menu contains the project input and output logfiles.

Input Log File

Displays the input logfile.

Output Log File

Displays the output logfile. The input logfile is appended to the output logfile.

Open Project Folder (Windows

Explorer)

Opens project folder in Window Explorer from within RAMMS. Ell

Help

RAMMS User Manual (pdf)

Friction Parameter Table
(pdf)

RAMMS License Agreement

RAMMS User Manual in pdf format.

Table of MuXi friction values in pdf format.

RAMMS License Agreement

Opens the RAMMS FAQ website at

RAMMS FAQ https://www.ramms.ch/faq/ in a web browser.

RAMMS Website F)pens the RAMMS website at https://www.ramms.ch
in a web browser.

Update... Download RAMMS updates manually or directly from
the web.

Update... Web Update Start web update procedure. RAMMS checks online if

there is an update available.

Get Update Manually
(download to local folder)

Download the update to a local folder.

Install Update from local
folder

Install the update from a local folder.

Update/Register License Key

Edit your existing license file or add/register a new
license key (module).

Advanced...

Color Tables — View Avail-
able Color Tables

Additional Preferences -
Edit

Reset General Preferences

Choose a different type of color scheme for your
colorbar.

Only for experts. Please contact support@rammes.ch if
you have questions about the additional preferences.

Reset your general preferences (working directory,
map directory etc.).

Install C++ Libraries

It is possible, that the Visual C++ Redistributable librar-
ies for Visual Studio 2015 (x64) are not installed on
your PC/laptop. These libraries are needed to run
RAMMS. In case they are missing, you are not able to
run simulations. Run this function to install these
libraries (Admin privileges required).
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e Logging Checkbox. Switch logging ON or OFF.

Checkbox. Switch AutoWebUpdate ON or OFF. If Au-
toWebUpdate is ON, then RAMMS will check for up-
* AutoWebUpdate dates whenever you start RAMMS.

Checkbox. Switch hardware rendering ON or OFF. If
hardware rendering is switched ON, then all graphical
rendering is done by your hardware, otherwise by IDL
(RAMMS). It is suggested to switch hardware rendering
OFF.

e Hardware Rendering

Checkbox. Switch curvature ON or OFF. See section
3.1.4 on page 16 for more information about curva-

* Curvature ture. Default is ON.

If you have a problem using RAMMS, please send us
e Technical Support Infor- the information from the Technical Support Infor-
mation mation together with any error screenshots from
RAMMS.

Show Information about the RAMMS releases in pdf

RAMMS Changelog format

About RAMMS About RAMMS information window.
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5.1.2 Horizontal toolbar

Project wizard: open avalanche wizard for creating a new avalanche project. (Ctrl + W)

Open input file. (Ctrl + O)

Open simulation. (Ctrl + A)

INPUT | Save copy as: save the active file under a new name.

INPUT and OUTPUT | Close: close the active file.

Print: displays the Windows print manager.

Undo, Redo.

Arrow (move and resize), Rotate, Move.

Simulation Results: Choose this function and move the arrow over the topography = x-,
y- and z-Coordinates of the mouse position are shown in the lower right status bar (see
Figure 5-11 on page 99).

OUTPUT | If you move the arrow over the simulation data, the active parameter is
shown as well (see Figure 5-11 on page 99). If you click once with the left mouse but-
ton at a point of interest, a new window pops up called ‘RAMMS::AVALANCHE Time Plot
<Active Parameter>’.

INPUT, 2D | Draw new polygon shapefile: specify new polygon-points by clicking the left
mouse button, finish with a right mouse click. The user is asked if he/she wants to draw
more polygons. At last, he/sh has to specify a new filename for the polygon shapefile.

INPUT, 2D | Draw new calculation domain: specify a new calculation domain polygon by
clicking with left mouse button, finish with a right mouse click. A dialog box will then ask
the user for a new domain name (e.g. domain), and a polygon shapefile is saved.

OUTPUT, 2D | Line Profile: Select the topography, until the Line-Profile-Button is active.
Click the button and then move the cursor to the start point of your profile. Click the left
mouse button and move the cursor to the next position of your profile. Finish with a
right mouse button click. A new window pops up called ‘RAMMS::AVALANCHE Line
Profile Plot Active Parameter’. This line profile plot is linked to your simulation. If you
change the parameter or if you change the max-value in the avalanche panel, the
changes are adapted in the line profile plot too. When animating the simulation, the line
profile is animated too.

2D |Measure distance and angle: Click with left mouse button; distance and angle be-
tween clicks is shown in the lower right status bar. Finish with a right mouse click.

i

INPUT, 2D | View and Edit Release Areas.

EJ [100% ~]

Zoom tools.

AlNolo|ele

Annotation tools, text, line, rectangle, oval, polygon, freehand. They can be activated
and deactivated in the additional preferences.
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Preferences =2 Advanced... =2 Edit 2 Annotations

=

INPUT | Create new MuXi File (Automatic Procedure).

Analysis of the input DEM: Slope Angle, Curvature and Contour Plots. Remove visualiza-
tion by clicking the button again.

%A
<
[@

OUTPUT | Show dump step values of the simulation result: Flow Height.

OUTPUT | Show maximum values of the simulation results: Max Flow Height, Max Flow
Velocity and Max Pressure.

L@E@
®
®

OUTPUT, 2D |Create a time plot for the last point location.

Tea

OUTPUT | Export the results to ASCII grid.

Open project folder in Windows Explorer.

{fs}

@) Add/change maps/orthophotos.
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5.1.3 Vertical toolbar

4

Add data to visualization (*.shp, *.asc).

OUTPUT | Switch to corresponding input file.

Show/hide lights.

Show/hide mesh.

/| 1| = | & | [«

INPUT | Show/hide release area (or active parameter).

OUTPUT | show/hide simulation.

Show/hide colorbar.

OUTPUT | Show/hide velocity vector arrow.

Show map.

&l |8 | /| (3]

Show image.

INPUT | Open Run Simulation window.

OUTPUT | Animate Simulation / Continue Simulation.

Stop/Pause Simulation (Iﬂ).

OUTPUT | End Simulation: skip to last dump-step of simulation.

Create a screenshot of the main window.

OUTPUT | Create GIF animation.

Change RAMMS Additional Preferences.

Edit dataspace properties.

Change RAMMS preferences (e.g. working directory).

Change view to 2D / Change view to 3D ( 3_Dl ).

© L |mo =kl |le

Refresh visualization (if stuck).
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5.1.4 Main window

€ RAMMS: AVALANCHE 1.8.0 - [EARAMMS\AVALANCHE\Beispiele\Test\ Test.out.gz] - m} x
Track Edit Input Show FRun Results GIS Extras Project Help

SEE mE o~ woMmeLelln 2 2 ANDocece M EVE 00®@ k B Ee

\VALANCHE
i I
RAMETER: Flow height (m) "I
‘:; MIN | MAX | COLORS r TRANSPARENCY / CONTOURS —
H MAX o Transparency % ° I
: < >
@ MIN
[ | ’ L Simulation Contour Lines I
COLORS o @% o |
7 |
Various I
189 Files  General Volu
X a9
- r Shapefiles, MuXi-Files am\Damais I
® 0.00 I
+ |C
& =3 Polygon I
& i [[g] domainshp
D@ Release.shp I
- @ secondrel shp
-2 MuXi
4)-(Z] Domain I
. |
e Time = 0s u ]
- [ 35 |
@ —_—eem e mm Em Em Em Em o= =
Time (s): 0.00
¢ >

XY Z-coordinates in lower right status bar No data

Figure 5-2: Main visualization window and information panel.

The RAMMS GUI (Graphical User Interface) consists of two main regions, see Figure 5-2:

1. Main visualization window
2. Information panel, see section below.

5.1.5 Panel

An AVALANCHE panel is displayed on the right side of the RAMMS GUI (Figure 5-2), and consists of
the display part, where visualization and colorbar settings can be set (MIN/MAX/COLORS and
TRANSPARENCY/CONTOURS, and four tabs (Files, General, Volumes and Region). Always confirm with
ENTER (return key) when changing a value! Additionally, the PARAMETER line states the visible pa-
rameter (e.g. Release height (m) in the Figure below, red box). Simulation contour lines can only be
shown for an output result (see Figure 3-35).
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AVALANCHE

PARAMETER: Release height (m)

- MIN | MAX /| COLORS ———— 1 TRANSPARENCY / CONTOURS ——

MAX II'ITrinsparen c'_.;%
e Simulation Contour Lines

COLORS

- Various

Files  General Volumes Region

Figure 5-3: AVALANCHE panel with four tabs

The Min and Max values as well as the number of colors influence directly the colorbar and the visu-
alization. The transparency changes the visibility of the result: 0% means no transparency, 100%
means total transparency, see Figure below. The colorbar is divided into N (nr. of colors) different
colors.

" AT . L

Figure 5-4: No ransparenc (left) and 40% transparency (righ;c) of simulation result.

-t .
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Files tab

The Files tab (Figure 5-5) shows a file tree with nodes for polygon shapefiles (Polygon, *.shp), MuXi-

files (MuXi, *.asc) and calculation domain files (Domain, *.shp). See section 3.4.2 on page 27 on how
to use the Files tab.

AVALANCHE

PARAMETER: Release height (m)

r MIN/ MAX /COLORS ———— TRANSPARENCY / CONTOURS ——

WA o Transparency %
(o] > @
o[ ]
o Simulation Contour Lines
COLORS o

- Various

Files General Volumes Region

r Shapefiles, MuXi-Files and Domain-Files

+|[c

(=25 Polygon

..... & domain.shp

----- [E] Release.shp finput)
..... [ &) secondrel shp

..... [JE Testshp

=423 Mu¥i

----- & L30_mu asc (nput)
----- [ L30_xiasc

[=-45] Domain

..... C1E Testshp

----- [£] domain shp (input)

Figure 5-5: Avalanche panel — Files tab
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General tab

The General tab (Figure 5-6) shows important simulation parameters, such as: nr. of nodes, nr. of
cells, end time (s), dump-step (s), grid resolution (m) and density (kg/m?3). In input mode, for handling
and visualization purposes, the topographic information is resampled, such that there are only
~50’000 grid cells remaining (see Visualization Resampling Remarks below, red box). This does not
influence any simulation at all, it simply makes the users life easier to zoom and rotate the topogra-
phy.

AVALANCHE

PARAMETER: Release height (m)

r MIN / MAX | COLORS ——— -~ TRANSPARENCY / CONTOURS ——
MAX 6 Transparency %

(o)< > @
m 0 Simulation Contour Lines

COLORS (i ]

- Various

Files General Volumes Region

- Simulation Parameters

Nr of nodes 2000000

Nr of cells 1997001

End time () 300
Dump step (5) 2.00
Grid resolution {m) 20

Awvalanche density (kg/im3) 300

II

Visualization Resampling Remarks:
Topography Resolution: 13
Topography Mr of Cells: 49455
Topography Mr of Nodes: 459028

Figure 5-6: Avalanche panel — General tab

96



CHAPTER Error! Use the Home tab to apply Uberschrift 1 to the text that you want to

appear here.: APPENDIX

Volumes tab

The Volumes tab (Figure 5-7) gives the user information about

e projected release area (m?)
e inclined (3D) release area (m?)

e release volume (m?, estimated in input mode)

e Flow volume (m3)

e Outflow volume (m3), volume flowing out of the calculation domain

| AVALANCHE

PARAMETER: Flow height (m)

r MIN | MAX | COLORS

e °
MIN o
COLORS i ]

- TRANSPARENCY / CONTOURS ——

Transparency %

EI( > &

Simulation Contour Lines

2 X &

- Various

Fles  General Volumes

Outflow volume (m3)

- Volume and Release Information
Proj rel area (m2) 245700.0
Incl rel area (m2) 3139427
Release volume (m3) 69417.2

Flow volume (m3) §9416.5

Region

Update avalanche volume

c

Figure 5-7: Avalanche panel — Volumes tab

Click the Update avalanche volume button (in output mode, red box), if the flow volume is not up-

dated automatically.
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Region tab

The Region tab (Figure 5-8) gives information about min, max and diff X-, Y-coordinates and the alti-
tude limits as well as information about the region area in km2.

- Various

Fles  General Volumes Region

- Project Region Information

¥ extent (m) 2586397.0 |- | 2587792.0 | 1385.0m
Y extent (m) 1162413.0 |- | 1164273.0 | 1860.0m
Z extent (m) 1053.4 - 2089.0 10356 m
Proj area (km2}) 1.477

Figure 5-8: Avalanche panel — Region tab

5.1.6 Time step slider

The time slider can be moved manually to change the active time (only in output mode).

Time (s} 20.00

Figure 5-9: The active time (20s) is shown in the time slider.

5.1.7 Left status bar

The left status bar is used to display status information for operations or informational messages
pertaining to the currently selected surface or manipulators.

2 | 2
Dump Steps
|Eonholling vizualizations, please wait., [57.555]

Figure 5-10: Status information shown in the left status bar.
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5.1.8 Right status bar

The right status bar is used to display the position of the cursor within the surface and additional
simulation results at the position of the cursor.

X 788009 Y: 195396 Altitude (m): 1679 Flow height (m): 1.70430

Figure 5-11: Position information and simulation results in the right status bar.

5.1.9 Colorbar

In general, the colorbar appears at the right m

edge of the main window (Figure 5-2) and 0.00 0.50 1.00 1.50 200 250
can be moved and resized (see section 3.4.6 Flow height (m)

on page 34).
page 34) Figure 5-12: Colorbar
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6 References and further reading

6.1 References

Maps and aerial images

=>» Topographic base maps and aerial images (Source: Federal Office of Topography)

Literature

[1] Johannesson et al., 2009: The design of avalanche protection dams. Recent practical and the-
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[2] Rudolf-Miklau, F. and Sauermoser, S., 2011: Handbuch Technischer Lawinenschutz. Ernst &
Sohn GmbH&Co.

[3] Salm, B.; Burkard, A. and Gubler, H., 1990: Berechnung von Fliesslawinen: eine Anleitung fiir
Praktiker mit Beispielen. Mitteilung 47, Eidg. Institut fiir Schnee- und Lawinenforschung SLF.

[4] Salm, B., 1993: Flow, flow transition and runout distances of flowing avalanches. In: Annals of
Glaciology 18, 221-226.

[5] Bartelt, P.; Vera Valero, C.; Feistl, T.; Christen, M.; Blhler, Y.; Buser, O., 2015: Modelling cohe-
sion in snow avalanche flow. Journal of Glaciology, 61, 229: 837-850. doi:
10.3189/2015J0G14J126

[6] Fischer, J.-T.; Kowalski, J.; Pudasaini, S.P., 2012: Topographic curvature effects in applied ava-
lanche modeling. Cold Regions Science and Technology, Volumes 74-75, May 2012, Pages 21-30.

6.2 Publications
The development of RAMMS is based on scientific findings published in international scientific
journals. A list of the most important scientific publications about RAMMS::Avalanche and its

applications can be found on the module page at https://www.ramms.ch/ramms-avalanche/.

Check out the Publication-list at the bottom of the page.
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7 Appendix

7.1 MuXi-Table

The following friction parameters (1 and € values) are used in RAMMS. Return period and volume
category can be changed in Input = Global Parameters.
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Large avalanche ( > 60'000 m?) 300-Year 100-Year 30-Year 10-Year
Altitude
(m.a.s.l.) H 3 H g H g H 3
above 1500 0.155 3000 0.165 3000 0.17 3000 0.18 3000
unchannelled 1000 - 1500 0.17 2500 0.18 2500 0.19 2500 0.2 2500
below 1000 0.19 2000 0.2 2000 0.21 2000 0.22 2000
above 1500 0.21 2000 0.22 2000 0.225 2000 0.235 2000
channelled 1000 - 1500 0.22 1750 0.23 1750 0.24 1750 0.25 1750
below 1000 0.24 1500 0.25 1500 0.26 1500 0.27 1500
above 1500 0.27 1500 0.28 1500 0.29 1500 0.3 1500
gully 1000 - 1500 0.285 1350 0.3 1350 0.31 1350 0.325 1350
below 1000 0.3 1200 0.315 1200 0.33 1200 0.345 1200
above 1500 0.14 4000 0.15 4000 0.155 4000 0.16 4000
flat 1000 - 1500 0.15 3500 0.16 3500 0.17 3500 0.18 3500
below 1000 0.17 3000 0.18 3000 0.19 3000 0.2 3000
Medium avalanche ( 25 - 60'000 m?®) 300-Year 100-Year 30-Year 10-Year
above 1500 0.195 2500 0.205 2500 0.215 2500 0.225 2500
unchannelled 1000 - 1500 0.21 2100 0.22 2100 0.23 2100 0.24 2100
below 1000 0.23 1750 0.24 1750 0.25 1750 0.26 1750
above 1500 0.25 1750 0.26 1750 0.27 1750 0.28 1750
channelled 1000 - 1500 0.27 1530 0.28 1530 0.285 1530 0.295 1530
below 1000 0.28 1350 0.29 1350 0.3 1350 0.31 1350
above 1500 0.32 1350 0.33 1350 0.34 1350 0.35 1350
gully 1000 - 1500 0.33 1200 0.34 1200 0.355 1200 0.36 1200
below 1000 0.36 1100 0.37 1100 0.38 1100 0.39 1100
above 1500 0.17 3250 0.18 3250 0.19 3250 0.2 3250
flat 1000 - 1500 0.19 2900 0.2 2900 0.21 2900 0.22 2900
below 1000 0.21 2500 0.22 2500 0.23 2500 0.24 2500
forested area (mu=delta, xi=fix) 0.02 400 0.02 400 0.02 400 0.02 400
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Small avalanche ( 5 - 25'000 m?) 300-Year 100-Year 30-Year 10-Year
Altitude
(m.a.s.l.) H 3 H 3 H 3 H g
above 1500 0.235 2000 0.245 2000 0.25 2000 0.26 2000
unchannelled 1000 - 1500 0.25 1750 0.26 1750 0.265 1750 0.275 1750
below 1000 0.265 1500 0.275 1500 0.285 1500 0.295 1500
above 1500 0.28 1500 0.29 1500 0.3 1500 0.31 1500
channelled 1000 - 1500 0.3 1350 0.31 1350 0.315 1350 0.325 1350
below 1000 0.31 1200 0.32 1200 0.33 1200 0.34 1200
above 1500 0.37 1200 0.38 1200 0.39 1200 0.4 1200
gully 1000 - 1500 0.38 1100 0.39 1100 0.4 1100 0.41 1100
below 1000 0.4 1000 0.41 1000 0.42 1000 0.43 1000
above 1500 0.215 2500 0.225 2500 0.23 2500 0.24 2500
flat 1000 - 1500 0.23 2250 0.24 2250 0.245 2250 0.255 2250
below 1000 0.245 2000 0.255 2000 0.26 2000 0.27 2000
Tiny avalanche ( < 5'000 m?) 300-Year 100-Year 30-Year 10-Year
above 1500 0.275 1500 0.28 1500 0.285 1500 0.29 1500
unchannelled 1000 - 1500 0.29 1400 0.295 1400 0.3 1400 0.305 1400
below 1000 0.3 1250 0.31 1250 0.32 1250 0.33 1250
above 1500 0.31 1250 0.32 1250 0.33 1250 0.34 1250
channelled 1000 - 1500 0.33 1180 0.34 1180 0.345 1180 0.355 1180
below 1000 0.34 1050 0.35 1050 0.36 1050 0.37 1050
above 1500 0.42 1050 0.43 1050 0.44 1050 0.45 1050
gully 1000 - 1500 0.43 1000 0.44 1000 0.45 1000 0.46 1000
below 1000 0.44 900 0.45 900 0.46 900 0.47 900
above 1500 0.26 1750 0.265 1750 0.27 1750 0.275 1750
flat 1000 - 1500 0.27 1600 0.275 1600 0.28 1600 0.285 1600
below 1000 0.28 1500 0.285 1500 0.29 1500 0.295 1500
forested area (mu=delta, xi=fix) 0.02 400 0.02 400 0.02 400 0.02 400

103



List of Figures

FIGURE 2-1: INSTALLATION - WELCOME DIALOG WINDOW.......cocciiiiiiiiiiiiiiiiiiiccin e 5
FIGURE 2-2: INSTALLATION - README DIALOG WINDOW. .....cooviiiiiiiiiiiiiicniiiccc s 5
FIGURE 2-3: INSTALLATION - LICENSE AGREEMENT DIALOG WINDOW.......cocciiiiiiiiiiiiiiiiinc e, 6
FIGURE 2-4: INSTALLATION - DESTINATION DIRECTORY DIALOG WINDOW......cccccovuiiiiiiiiiiiniciicncce e, 6
FIGURE 2-5: INSTALLATION - INSTALLING FILES DIALOG WINDOW. ....cceiiiiiiiiiiiiiiiiiciecc e 7
FIGURE 2-6 : INSTALLATION - FINISHED INSTALLING FILES DIALOG WINDOW. ......ccocuiiiiiiiiiiiiiiiiicieciceeeee, 7
FIGURE 2-7: INSTALLATION - FINISHED INSTALLATION DIALOG WINDOW. ......coocuiiiiiiiiiiiiiiiiccnicrccecccne, 8
FIGURE 2-8: IDLVISUAL STUDIO MERGE MODULES - WELCOME DIALOG WINDOW. .......ccccvvviiiniiiiiiiniiciieenee, 8
FIGURE 2-9: IDLVISUAL STUDIO MERGE MODULES - READY TO INSTALL THE PROGRAM........cccovviiiniiiiiinnen. 9
FIGURE 2-10: IDLVISUAL STUDIO MERGE MODULES - INSTALLING... ...cccviiiiiiiiiiiiiiiiiic e 9
FIGURE 2-11: INSTALLATION - DESTINATION DIRECTORY DIALOG WINDOW.......cccoirimiiiiiiiiiiiiiiiciecccnieee 10
FIGURE 2-12: RAMMS ICON. ...oiiiiiiiiiiiii ittt bbb bbb s s b s s aeeeae 10
FIGURE 2-13: RAMMS PROGRAM GROUP ..ottt 10
FIGURE 2-14: RAMMS START WINDOW. .....ciiiiiiiiiiiiiiiiccin et 11
FIGURE 2-15: RAMMS LICENSING WINDOW ......ccoiiiiiiiiiiiiiiiiiicii e 11
FIGURE 2-16: ENTER USER NAME AND COMPANY NAME. ....ccciiiiiiiiiiiiiiiii e 12
FIGURE 2-17: PERSONAL LICENSE REQUEST FILE RAMMS_DBF_REQUEST_TESTNAME.TXT ....ccovviiiiiiiiiiiniinnne 12
FIGURE 2-18: PERSONAL LICENSE KEY FILE RAMMS_LICENSE_MUSTER TEST.TXT ...ooiviiiiiiiiiiiiiiiiiiiieeciiieee 13
FIGURE 3-1 : EXAMPLE ESRIASCIIGRID. .ttt 14
FIGURE 3-2: EXAMPLE ASCIH XYZ SINGLE SPACE DATA. ...ciiiiiiiiiiiiiiiit i 14
FIGURE 3-3: PROJECT EXTENT (AREA OF INTEREST) c.cecteitietirieeiteienieie sttt sttt st s st 15
FIGURE 3-4: RELATION BETWEEN NORMAL AND SHEAR STRESS.........coiiiiiiiiiiiiiiiciin e 17
FIGURE 3-5: AUTOMATIC TERRAIN ANALYSIS IN RAMMS.....cooiiiiiiiiiiiiiiici e 18
FIGURE 3-6: AUTOMATIC ASSIGNING OF g AND = VALUES TO GRID CELLS.......coovviiiiiiiiiiniiiiiiiiiecciieee 18
FIGURE 3-7: ALTITUDE LIMITS FOR AUTOMATIC MUXI PROCEDURE..........ccociiiiiiiiiiiiiiiiiciiecec e 19
FIGURE 3-8: RAMMS GLOBAL PARAMETERS. ..ottt 20
FIGURE 3-9: GENERAL TAB OF RAMMS PREFERENCES. ......ccoiiiiiiiiiiiiiiiiiiciiiciiicc e 21
FIGURE 3-10: AVALANCHE TAB OF RAMMS PREFERENCES........ccccoiviiiiiiiiiiiiiiiciiinincc s 21
FIGURE 3-11: RAMMS PREFERENCES ..ottt 22
FIGURE 3-12: BROWSE FOR THE CORRECT FOLDER. .....uciiiiiiiiiiiiiiiiciii s 22
FIGURE 3-13: RAMMS PROJECT WIZARD STEP 1 OF 4 ....coiiiiiiiiiiiiiiiicniicc e 23
FIGURE 3-14: STEP 1 OF THE RAMMS PROJECT WIZARD PROJECT INFORMATION. .....cocoiiiiiiiiiiiiiiiiiiciiiniiies 24
FIGURE 3-15: WINDOW TO BROWSE FOR A NEW PROJECT LOCATION. ....cceiiiiiiiiiiiiiiiiciiin e 24
FIGURE 3-16: STEP 2 OF THE RAMMS PROJECT WIZARD: GIS INFORMATION. ....cccovviiiiiiiiiiiiiininic e 24
FIGURE 3-17: PROJECT COORDINATES: LOWER LEFT AND UPPER RIGHT CORNER OF PROJECT AREA................. 25
FIGURE 3-18: STEP 3 OF THE RAMMS PROJECT WIZARD: PROJECT BOUNDARY COORDINATES. ......ccccceviiiiiinnns 25

104



FIGURE 3-19: STEP 4 OF THE RAMMS PROJECT WIZARD: PROJECT SUMMARY. ..cccuviiiiiiieiinriieieiine e 25

FIGURE 3-20: CREATED PROJECT FILES ..oooiiiiiiiiiiicti ettt 26
FIGURE 3-21: TOOLBAR BUTTON TO OPEN AN INPUT FILE. ......ccoiiiiiiiiiiiiiiiiii s 27
FIGURE 3-22: TOOLBAR BUTTON TO OPEN AN OUTPUT FILE. ...cocuiiiiiiiiiiiiiiiiii s 27
FIGURE 3-23: FILES TAB AND AVAILABLE PROJECT FILES (FILE-TREE, DASHED RED) ......cccceviiiiiiiiniiiincceeees 28
FIGURE 3-24: SELECTED FILE (RELEASE.SHP) ON THE RIGHT IS SHOWN IN THE VISUALIZATION. ......cccocvvvennnene 28
FIGURE 3-25: FILES-TAB: RIGHT-CLICK MENUS ......cociiiiiiiiiiiiiii e 29
FIGURE 3-26: USE SHAPEFILE PROPERTIES TO CHANGE LINE THICKNESS, COLOR OR LINESTYLE.......ccccevviunnnne 29

FIGURE 3-27 DEM SURFACE VISUALIZATION (WITH SHADOWS) AFTER CREATING A NEW PROJECT IN RAMMS 30

FIGURE 3-28 VISUALIZATION AFTER CREATING AND ADDING THE HILLSHADE IMAGE TO RAMMS .........cceeeee. 31
FIGURE 3-29: WINDOW TO CHOOSE MAP IMAGE. .......coiiiiiiiiiiiiiiiiiin e 32
FIGURE 3-30: ACTIVE PROJECT WITH LINES AND CORNERS FOR RESIZING. .......coovviiiiiiiiiiiiiiiiiiiiiec e 32
FIGURE 3-31: ACTIVE PROJECT WITH ROTATION AXES. ...coviiiiiiiiiiiiiiiin it 33
FIGURE 3-32: 3D VIEW OF EXAMPLE MODEL......cvtiiiiiiiiiiiiiiiiiiiii e 34
FIGURE 3-33: 2D VIEW OF EXAMPLE MODEL. ....ccuuiiiiiiiiiiiiiiiiiiciin s 34
FIGURE 3-34 COLORBAR AND VISUALIZATION PROPERTIES ......cooiiiiiiiiiiiiiiiiiin i 34
FIGURE 3-35: SIMULATION CONTOUR LINES ....cocutiiiiiiiiiiiiiiiiiiicciiiiic e 35
FIGURE 3-36: THE COLORBAR PROPERTIES WINDOW. ....ciiiiiiiiiiiiiiiiiiiiiiicn e 35
FIGURE 3-37: ABOUT RAMMS ....oiiiiiiii et sbe s s be e 37
FIGURE 3-38: DRAWING A NEW RELEASE AREA......coiiiiiiiiiiiiiiicci s 39
FIGURE 3-39: HOW TO VISUALIZE POLYGON SHAPEFILES ......cooiiiiiiiiiiiiiiiiiiic s 40
FIGURE 3-40: VIEW/EDIT RELEASE AREA........titiieiiitiietirtetettsteste sttt sttt st n ettt naese e 41
FIGURE 3-41: ABOUT ...oiiiiiiiiiicci ittt s b e e b s s ab s e b e s b s b be s e beeeaes 42
FIGURE 3-42: ABOUT ..ottt bbb s aae e s b e e s e bt e s s aan e e s sanaeeeea 43
FIGURE 3-43: RELEASE AREA AND VOLUME INFORMATION ......cocviiiiiiiiiiiiiiiiii e 43
FIGURE 3-44: CALCULATION DOMAIN L...oiitiiiiiiitiiiiii s 44
FIGURE 3-45: INPUT FILE WITH BIG CALCULATION DOMAIN.......ociiiiiiiiiiiiii i 45
FIGURE 3-46: MAX FLOW HEIGHT OF A 10M SIMULATION WITH CONSTANT MU AND Xl....ccccccovuvivinnniiininnienne 45
FIGURE 3-47: ENVELOPE SHAPEFILE OF MAX FLOW HEIGHT EXTENT ....oooiiiiiiiiiiiiiiiiiiicciccic s 46
FIGURE 3-48: INPUT FILE WITH OPTIMIZED CALCULATION DOMAIN (ENVELOPE SHAPEFILE).......ccccvvvererueennnnee 46
FIGURE 3-49: MAX FLOW HEIGHT RESULT OF A 5M SIMULATION WITH VARIABLE MUXI-FILE ........ccccvvvvinnnnnne 47
FIGURE 3-50: IMPORT FOREST FROM SHAPEFILE ........oooiiiiiiiiiiiiiiiicii s 48
FIGURE 3-51: RAMMS AUTOMATIC MUXI PROCEDURE. .......oooiiiiiiiiiiiiiiiiiccii s 50
FIGURE 3-52 GENERAL INFORMATION ...oiiiiiiiiiiiiiiiiiiiiiiiiiicc s s an s snae e 51
FIGURE 3-53: PARAMETER TAB ...ttt e s an e sna e 52
FIGURE 3-54: FRICTION VALUES MU AND Xl .oiiiiiiiiiiiiiiiiii it 53
FIGURE 3-55: RELEASE INFORMATION. ..ottt 53
FIGURE 3-56: CALCULATION STATUS WINDOW......ccoiiitiiitiiiiiicin ettt 54



FIGURE 3-57: BACKGROUND SIMULATION MODE WINDOW. ....ccciiiiiiiiiiiiiiiiiiiciiin i 55
FIGURE 3-58: BATCH-SIMULATIONS ....ovviiiiiiiiiiiiictin ettt 56
FIGURE 4-1: MAIN WINDOW IN OUTPUT MODE. ......ccoviiiiiiiiiiiiiiiiiiiciiic it 57
FIGURE 4-2: OUTFLOW VOLUME ALERT. ...ciiiiiiiiiiiiii it 57
FIGURE 4-3: OUTPUT LOGFILE.......iiiiiiiiiiiiiiiii sttt s 59
FIGURE 4-4: RAMMS PROJECT INPUT LOG FILE. ..ooiiiiiiiiiiiiiiticci ettt 60
FIGURE 4-5: REGION EXTENT (X-, Y- AND Z-COORDINATES, TOTAL PROJECTED AREA). .....cocvrverenieriinrenierieeeenes 60
FIGURE 4-6: RESULTS: MAXIMUM VALUES OF FLOW HEIGHT (LEFT), VELOCITY (MIDDLE) AND PRESSURE ........ 62
FIGURE 4-7: QUASI 3D-VISUALIZATION OF FLOW HEIGHT .....cooiiiiiiiiiiiiii e 62
FIGURE 4-8: LINE PROFILE PLOT. ..uttiiiiiiiiiiiiiicc ittt s saa s s 64
FIGURE 4-9: LINE PROFILE PERPENDICULAR TO FLOW DIRECTION. .....cciviuiiiiiiiiiiiiiiiiiiiciiccccinc e 65
FIGURE 4-10: LINE PROFILE ALONG THE FLOW DIRECTION. ....cciviiiiiiiiiiiiiiciiin s 65
FIGURE 4-11: TIME PLOT WINDOW. ..ottt 66
FIGURE 4-12: DEPOSITION ANALYSIS OF REGION OF INTEREST ....ccoviiiiiiiiiiiiiiiiiiiiiiecc e 68
FIGURE 4-13: RESULT OF A DEPOSITION ANALYSIS....oiiiiiiiiiiiiiiiiiic s 68
FIGURE 4-14: EXPORTED RESULT IN GOOGLE EARTH ....ooiiiiiiiiiiiiiiiicci s 69
FIGURE 4-15: GOOGLE EARTH OPTIONS ...ttt 70
FIGURE 4-16: GOOGLE EARTH PROJECTION AND SPHEROID (DATUM) DROP-DOWN MENUS........cccoevererernennen 71
FIGURE 4-17: THE TWO STOPPING CRITERIA AVAILABLE IN RAMMS .....ooiiiiiiiiiiiiiiiiicic e 72
FIGURE 4-18: SUMMARY OF MOVING MASS INFORMATION WINDOWS........ccccoiviiiiiiiiiiiiiiie i 73
FIGURE 4-19: STOPPING BEHAVIOUR OF A RAMMS SIMULATION ....ooiiiiiiiiiiiiiiiiiiiiiirec s 73
FIGURE 4-20: STOPPING BEHAVIOUR OF A RAMMS SIMULATION 2 ...cocuiiiiiiiiiiiiiiiiiniicciicc e 74
FIGURE 4-21: CENTER-OF-MASS TRAVEL SPEEDS ......coiiiiiiiiiiiiiiiiticc s 75
FIGURE 4-22: POLYGON AREA WHERE A DAM IS SUPPOSED TO BE BUILT. ...ccvviiiiiiiiiiiiiiiiniiicciicc e 76
FIGURE 4-23: NEW DEM WITH DAM AT LOCATION OF POLYGON SHAPEFILE. .....cccovviiiiiiiiiiiiiiiiiiciieee 76
FIGURE 4-24: SELECT NEW XYZ-FILE WITH DAM INFORMATION. ...ccocoiiiiiiiiiiiiiiiiciiin i 77
FIGURE 4-25: SIMULATION WITHOUT (LEFT) AND WITH (RIGHT) A DAM. ...ccutiiiieieriinieniteieeeeeenie e 77
FIGURE 4-26: DAM WITH GRADUALLY RISING SIDE WALLS. ....cccvviiiiiiiiiiiiiniiicciiec e 78
FIGURE 5-1: GRAPHICAL USER INTERFACE (GUI) ...ueoiiiiiiiiriiiieiieieteie sttt st s s 79
FIGURE 5-2: MAIN VISUALIZATION WINDOW AND INFORMATION PANEL. ....cccooviiiiiiiiiiiiiiiciecccic e 93
FIGURE 5-3: AVALANCHE PANEL WITH FOUR TABS ..ottt 94
FIGURE 5-4: NO TRANSPARENCY (LEFT) AND 40% TRANSPARENCY (RIGHT) OF SIMULATION RESULT................ 94
FIGURE 5-5: AVALANCHE PANEL — FILES TAB ...ttt s 95
FIGURE 5-6: AVALANCHE PANEL — GENERAL TAB ....cooiiiiiitiiiiiiiiciiii it 96
FIGURE 5-7: AVALANCHE PANEL — VOLUMES TAB.....utiiiiiiiiiiiiiiiiinc s 97
FIGURE 5-8: AVALANCHE PANEL — REGION TAB......ciiiiiiiiiiiiiiii e 98
FIGURE 5-9: THE ACTIVE TIME (20S) IS SHOWN IN THE TIME SLIDER. .....ccociiiiiiiiiiiiinccc e 98
FIGURE 5-10: STATUS INFORMATION SHOWN IN THE LEFT STATUS BAR......cooiiiiiiiiiiieccien e 98

106



FIGURE 5-11: POSITION INFORMATION AND SIMULATION RESULTS IN THE RIGHT STATUS BAR........ccccovviuiens 99
FIGURE 5-12: COLORBAR.....co ittt ittt s s b s bbb e e s s b b e e s s ba e s e saaneessabaeeeeas 99

List of tables

TABLE 1: MUXI ALTITUDE LIMITS, EXAMPLES FOR DIFFERENT CLIMATIC REGIONS ....cevviiiiiiiiiiirccieeec e 19
TABLE 3.2: LISTING OF FILES AND DIRECTORIES CREATED WITH A NEW RAMMS::AVALANCHE PROJECT........... 26

Third-Party Software
The following third-party software components are used in RAMMS:
7-zip:

e We sometimes use 7za.exe to zip data.
o 7-zipis licensed under GNU LGPL.
e The source code of 7-zip is available at www.7-zip.org.

Mtee:

e Mtee is a Win32 console application that sends any data it receives to stdout and to any
number of files.
e Mtee is released under MIT License https://ritchielawrence.github.io/mtee/.

107


http://www.7-zip.org/
https://ritchielawrence.github.io/mtee/

Index

K and § 17

A

Add Deposition to DEM 77
Altitude limits 19
AutoWebUpdate 13, 87

Background Color 22
BATCH calculations 56

Calculation domain 44
Calculation parameters 20
Center of mass 73
Cohesion 16

Colorbar 35

Curvature 17

Dam 74

Delay 43

Delete 30

Deposition analysis 30, 66

Digital Elevation Model (DEM) 14

Files tab 93

Forest 20

Friction 16

Friction parameters pand § 48

G

General tab 94
GEOTIFF 14

GIF animation 66, 71
Global parameters 20
Google Earth 68

GUI 78

H

Hillshade visualization 31
Horizontal toolbar 88

Import forest from shapefile 30
Input logfile 59
Installation 4

License request file 12
Licensing 11
Line profile 62, 63

MuXi-file 50
MuXi-Table 99

New project 23

Output Log File 58
Output logfile 58

Panel 91
Preferences 21
Program overview 78

Recent 80

Region tab 96
Release area(s) 39
Release properties 30
Results 57

Run a calculation 51

S

Secondary avalanche release 43
Shapefile properties 29
Simulation contour lines 36
Status bar 96

Stopping 71

System requirements 4

108



Time plot 62, 65
Time step slider 96

Update 13

Vertical toolbar 90
Voellmy 16
Volumes tab 95

Working Directory 21

109



